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Warranty

All products manufactured by ICP DAS are under warranty regarding defective materials for

a period of one year, beginning from the date of delivery to the original purchaser.

Warning
ICP DAS assumes no liability for any damage resulting from the use of this product. ICP DAS
reserves the right to change this manual at any time without notice. The information
furnished by ICP DAS is believed to be accurate and reliable. However, no responsibility is
assumed by ICP DAS for its use, not for any infringements of patents or other rights of third
parties resulting from its use.

Copyright
Copyright @ 2019 by ICP DAS Co., Ltd. All rights are reserved.

Trademark

The names used for identification only may be registered trademarks of their respective
companies.

Contact US
If you have any problem, please feel free to contact us.

You can count on us for quick response.

Email: service@icpdas.com
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1. Introduction

This chapter provides an overview of the WP-2000-CE7 series modules and its components, and

introduces the fundamental concepts for user familiar.

The WP-2000-CE7 series modules are equipped a Cortex-A8 CPU (1 GHz) and running a windows CE.NET
7.0 operating system. The optional I/O expansion board, XV-board, provides high-protection 1/0. Using
the built-in Flash and microSD, the WP-2000-CE7 series modules can save application program, image

file and data.

The 4G module of WP-2241MX-4GC-CE7 work on frequencies of WCDMA 900/2100 MHz, TDSCDMA
1900/2100 MHz, CDMA2000 (BC0) 800 MHz, FDD LTE:B1/B3/B8, TDD LTE: B38/B39/B40/B41 and GSM
850/900/1800/1900 MHz.

The 4G module of WP-2241MX-4GE-CE7 work on frequencies of WCDMA 2100/1900/900/850 MHz, FDD
LTE:B1/B3/B5/B7/B8/B20 and GSM 850/900/1800/1900 MHz.

These modules utilize the 4G and 3G network for convenient and inexpensive data transfer from remote
instruments, meters, computers or control systems in either live data or packet data. This module has

the integrated TCP/IP stack so that even simple controllers with serial communications ports can be
connected to the modem without the need for special driver implementation. With the features of theirs,

the systems can be SMS and GPRS and 4G or 3G connection applications with our PAC.
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1.1. Features

The WP-2000-CE7 series modules offer the most comprehensive configuration and remote system
upgrade solutions to meet specific application requirements. The following list shows the hardware and

software features designed to simplify installation, configuration and application.

»  Windows Embedded Compact 7.0

P Windows®
K Embedded

Compact 7

* Support PC based software: Visual Studio.NET

e Web server, FTP server, Telnet server

» Local I/0 and Communication Expansion Board

WP-2000-CE7 series module is equipped with an I/O expansion bus to support one optional
expansion board, called XV-board. It can be used to implement various I/O functions such as DI, DO,

A/D, D/A, Timer/Counter

For more information about these available expansion boards, please refer to

http://www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board selection

.html
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Various Memory Expansions

WP-2000-CE7 series module provides various memory storage options, such as

FRAM and microSD. Customers can choose the memory based on their iero

Adapter

characteristics.

* 16 KB FRAM: no limit on the number of write-erase cycles.

* microSD/microSDHC: to implement portable data logging applications; supports up to 32 GB.

Unique 64-bit Hardware Serial Number to Protect Your Program

A unique 64-bit serial number is assigned to each hardware device to

protect your software against piracy.

Remote I/0O Module and Expansion Unit

With the built-in RS-485 and Ethernet port, the WP-2000-CE7 series modules can connect
RS-485/Ethernet remote 1/0 units (RU-87Pn/ET-87Pn) or modules (I1-7000/M-7000/ET-7000).

[-8KE4 ET-7000

RS-232/RS-485

RU-87Pn M-7000 [-7000
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Plastic and Metal Housing

The WP-2000-CE7 series modules come with the metal casing.

Highly Reliable Under Harsh Environment

Our WP-2000-CE7 series modules operate in a wide range of temperature and humidity.

* Operating Temperature: -25~ +75 °C

* Storage Temperature: -40 ~ +80 °C
* Humidity: 10% ~ 90% RH, non-condensing
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1.2. Specifications

The table below summarizes the specifications of the WP-2000-CE7 series module.

1.2.1. WP-2241M-CE7 and WP-2241MX-CE7

Models WP-2241M-CE7 WP-2241MX-CE7

System Software

(0N Windows CE 7.0 Professional
Framework Support .Net Compact Framework 3.5
Embedded Service FTP Server, Web Server

SDK Provided DIl for Visual Studio.Net 2008

English, German, French, Spanish, Russian, Italian, Korean, Simplified
Multilanguage Support
Chinese, Traditional Chinese

CPU Module

CPU Cortex-A8, 1 GHz
DDR3 SDRAM 512 MB
Flash 256 MB
FRAM 64 KB

y

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year
64-bit Hardware Serial Number Yes, for software copy protection

Dual Watchdog Timers Yes

Rotary Switch Yes (0 to 9)

1 LED for Power, 1 LED for Running, 1 LED for mobile network and 3 LEDs
LED Indicators
for user defined

VGA & Communication Ports ‘

Resolution 640 x 480, 800 x 480, 800 x 600, 1024 x 768

Ethernet RJ-45 x 2, 10/100/1000 Base-TX
(Auto-negotiating, Auto MDI/MDI-X, LED indicators)

USB 2.0 2

com1 RS-232 (RxD, TxD, and GND); Non-isolated

COM 2 RS-232 (RxD, TxD, and GND); Non-isolated

CcCoOM 3 RS-485 (Data+, Data-); 2500 Vpc isolated

COM 4 RS-485 (Data+, Data-); 2500 Vpc isolated
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Models
1/0 Expansion

I/0 Expansion Bus

WP-2241M-CE7 WP-2241MX-CE7

Yes, one optional XV-board

4G Expansion Bus

Dimensions (W x H x D)

_ Yes

35mmx 167 mm x 119 mm

Housing

Metal

Installation

Operating Temperature

Environmental

DIN-rail mounting

-25°Cto+75°C

Storage Temperature

-40°Cto+80°C

Ambient Relative Humidity

Input Range

10 % to 90 % RH (non-condensing)

+12 Vpc to +48 Vpc

Consumption

4.8 W (0.2 A @ 24 Vp()

WP-2000-CE7 Series (WinCE7 Based) User Manual v1.04 Page: 11



1.2.2. WP-2241MX-4GC-CE7 and WP-2241MX-4GE-CE7

System Software

Models WP-2241MX-4GC-CE7 WP-2241MX-4GE-CE7

oS Windows CE 7.0 Professional
Framework Support .Net Compact Framework 3.5
Embedded Service FTP Server, Web Server

SDK Provided DIl for Visual Studio.Net 2008

English, German, French, Spanish, Russian, Italian, Korean, Simplified
Multilanguage Support
Chinese, Traditional Chinese

CPU Module

CPU Cortex-A8, 1 GHz
DDR3 SDRAM 512 MB
Flash 256 MB
FRAM 64 KB

microSD socket with one 4 GB microSD card

Expansion Flash Memory
(support up to 32 GB microSDHC card)

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year
64-bit Hardware Serial Number Yes, for software copy protection

Dual Watchdog Timers Yes

Rotary Switch Yes (0 to 9)

1 LED for Power, 1 LED for Running, 1 LED for mobile network and 3 LEDs
LED Indicators
for user defined

VGA & Communication Ports

Resolution 640 x 480, 800 x 480, 800 x 600, 1024 x 768

Ethernet RJ-45 x 2, 10/100/1000 Base-TX
(Auto-negotiating, Auto MDI/MDI-X, LED indicators)

USB 2.0 2

comMm1 RS-232 (RxD, TxD, and GND); Non-isolated

COM 2 RS-232 (RxD, TxD, and GND); Non-isolated

CcoOM 3 RS-485 (Data+, Data-); 2500 V;c isolated

COM 4 RS-485 (Data+, Data-); 2500 Vp isolated

I/0O Expansion Bus Yes, one optional XV-board

4G Expansion Bus Yes
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Models

Mechanical

WP-2241MX-4GC-CE7

WP-2241MX-4GE-CE7

Dimensions (W x H x D)

35mm x 167 mm x 119 mm

Housing

Metal

Installation

Operating Temperature

Environmental ‘

DIN-rail mounting

-25°Cto+75°C

Storage Temperature

-40°Cto +80 °C

Ambient Relative Humidity

Input Range

10 % to 90 % RH (non-condensing)

+12 Vpc to +48 Vi

Consumption

Frequency Band

4.8W (0.2 A @ 24 V)

GSM: 850/900/1800/1900 MHz

GPRS Connectivity

GPRS class 12/10, GPRS station class B

Data GPRS

Frequency Band

3G System

Downlink transfer: Max. 85.6 kbps, Uplink transfer: Max 42.8 kbps

WCDMA 900/2100, TD-SCDMA
WCDMA 850/900/2100 MHz

1900/2100, CDMA2000 (BC0) 800 MHz

Data Transmission

Frequency Band

DC-HSPA+ Download: Max. 42 Mbps, Upload: Max 5.76 Mbps; TD-SCDMA
Download: Max. 4.2 Mbps, Upload: Max 2.2 Mbps; CDMA2000 EVDO Download:

Max. 14.7 Mbps, Upload: Max 5.4 Mbps

FDD LTE: B1/B3/B8, TDD LTE:

FDD LTE: B1/B3/B5/B7/B8/B20 MHz
B38/B39/B40/B41 MHz

Data Transmission

Download Max: 100 Mbps, Upload: Max 50 Mbps

WP-2000-CE7 Series (WinCE7 Based) User Manual

v1.0.4 Page: 13



1.3. Overview

WP-2000-CE7 series module is equipped with several interfaces and peripherals that can be integrated

with external systems. Here is an overview of the components and its descriptions.

Front View

)
m'— LED Indicators

ol

r‘ﬂ_l,-_l_ USB Port x 2

—

Ethernet Port x 2 —l

@=——==microSD Card Socket

XV-Board Slot =——2@
== Pin Assignment

Item ‘ Description ‘

LED Indicators The WP-2000-CE7 series module has 6 LED indicators shown as below.

O O O

RUN PWR

ALY,

LEDIndicator‘ Color | Meaning ‘

RUN Green Power on and OS is running

PWR Red Power is on.

L1 Green

L2 Orange | User programmable LED indicator.
L3 Red
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Item Description

Ethernet Port The WP-2000-CE7 series module has an Ethernet port
that can be connected to a computer or device via an

Ethernet cable.

The Link/Act and 1G LED indicators display the status of
the WP-2000-CE7 series module. The details are shown

Link/Act LAN2 16 Link/Ad LAN1 16

as below.
LED Indicator | State (Color) | Meaning
ON (Orange) Network Speed: 1 G
1 OFF Network Speed: 10/100 M
ON (Green) The Link is active
Link/Act OFF The Link is inactive
Blinking(Green) Network activity

USB Port s The WP-2000-CE7 series module has two USB 2.0 port
P1  that allows support for the USB devices such as mouse,
keyboard or an external USB hard drive.
o>
P2
microSD Card The microSD socketcan be used to restore the WP-2000-CE7 series module
Socket system and expand the memory up to 32 GB.
XV-Board Slot The XV-board slot can be used to support up to one XV-board service.
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Item Description ‘

Pin Assignment

Signal Description

[

TxD

RXD COM1 (RS-232)

GND

TxD

RxD COM2 (RS-232)

GND

D- COMS3 (RS-485)

O |0 (N oo (u |~ [w N

ISO.GND

[any
o

D+

=
-

D- COM4 (RS-485)

[any
N

ISO.GND
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Top View

Antenna Connector Rotary Switch

VGA Port Power Input and
Frame Ground

Item Description ‘
Antenna Connector | (for WP-2241M-4GC-CE7 and WP-2241M-4GE-CE7 only)
The WP-2241M-4GC-CE7 and WP-2241M-4GE-CE7 has an antenna connector

that can be used to connect the antenna.

VGA Port A VGA connector is a 3-row 15-pin connector that can be used with a variety
of supported VGA resolutions, and the output resolution covers 640x480,
800x480, 800x600, 1024x768.

Rotary Switch Rotary Switch is an operating mode selector switch which provides seven

functions related to the selection of the operating mode.

Power Input and The WP-2000-CE7 series modules has a terminal with 3pins, there are 2 pins

Frame Ground for power input and a pin for frame ground as follows:

E (rec.

PGND =

|— Power Input

PWR =
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1.4. Dimensions

The diagrams below provide the dimensions of the WP-2000-CE7 series modules to use in defining your
enclosure specifications. Remember to leave room for potential expansion if you are using other

components in your system.

All dimensions are in millimeters.

So00000000000000000000

Top View
- 1281
119.0
110.0 35.0
(B8] nron Fs S — P
)
° I— ooo
' o000
62.2
I
g 167.0 "]]
331 ° 157.0| [é:l
61.7
®
o e
Left Side View Front View Right Side View
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2. Getting Started

This chapter provides a guided tour of the WP-2000-CE7 series modules installation and configuration
that describes the steps needed to download, install, configure, and run the basic procedures for user

working with the WP-2000-CE7 series modules for the first time.

Before starting any task, please check the package contents. If any of the following package contents are

missing or damaged, contact your dealer, distributor.

A

=13 ’

———— A, Puoex
T "I
e Adapter

/
WP-2000-CE7 Series A microSD card and Screw Driver
WP-2000-CE7 Quick Start Guide a micro SD/SD adapter (1C016) 2.4 mm

oo

44 mm DIN-Rail Clip M3x6L Screw * 4 Wire Terminal * 16

I
I

The following items are included with mobile network expansion card

GSM/GPRS External
Antenna (ANT-421-04)
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2.1. Mounting the Hardware

The WP-2000-CE7 series module has simple rail clips for mounting reliably on a standard 44 mm DIN rail.

Step 1: Mounting WP-2000-CE7 onto a 44 mm DIN rail
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Step 2: Connecting to a PC, the USB device, and the power supply

i.  Connect the mouse or keyboard to the USB port.

ii. Connect PC to the Ethernet port through an Ethernet switch.

iii. Connect the power supply (+12 to +48 VDC) to PWR and P.GND terminals.
iv. Connect the monitor to the VGA port.

Power Supply +12 to +48 VDC

VGA Port

f
Monitor
USB Port —— ﬁ

LAN Port

USB Mouse/USB Keyboard

Ethernet Switch PC or Laptop
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2.2. Mounting the Expansion Components/Accessories

2.2.1. Mounting the XV-Board

WP-2000-CE7 series modules have one expansion I/O slots to expand the functions. For more detailed

information about the XV-board specifications, please refer to Appendix B. XV-Board Modules.

Step 1: Remove stripped screws and then remove the cover

ﬁ
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Step 2: Hold the XV-board vertically and align the socket, and then carefully press the XV-board onto

the 1/0 expansion bus

Step 3: Fasten the XV-board using the screws supplied
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Step 4: Close the cover and then fasten the screws

'

Step 5: Insert the 1/0 terminal
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2.2.2. Inserting the SIM Card

(for Mobile network expansion card had installed)

The SIM card tray is located on the top side of the module. The eject button is on the right side of the

tray door.

Step 1: Remove stripped screws and then
remove the cover

Step 2: Insert the SIM card into the Socket and

Step 3: Close the cover and then fasten the screws

Tips & Warnings

Q Make sure to turn the WP-2000-CE7 off before inserting or removing the SIM card. Do not
bend or scratch the SIM card.
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2.2.3. Installin the 3G/4G Communication LTE Module

(for Mobile network expansion card had installed)

Step 1: Remove stripped screws and then
remove the cover

Step 2: Remove the fixed tape and move the
cable to the edge

Remove the cable

Step 3: Insert the 3G/4G communication to the edge

module and use the screws to secure it
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Step 4: connect the cable and then put the cable inside

Put the cable inside

Step 5: Close the cover and then fasten the screws
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2.2.4. Installing the antenna

(for Mobile network expansion card had installed)

The Mobile network expansion card has an antenna connector that can be used to connect the 3G/4G
antenna. To install the antenna, just screw the antenna tightly into the connector, and put the antenna in

the purpose place.
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2.3. Configuring the Boot Mode

The WP-2000-CE7 series modules have several operating modes, which can be selected by a rotary

switch.

The table below lists the operation modes available with the WP-2000-CE7.

Position Operating Mode

0 Normal mode (Default)

1 Safe mode

2 Debug mode

3 OS update mode by Ethernet

4 Reserve

5 OS update mode by Micro_SD

6 Reserve (OS Development Mode)
7~9 User Mode

The following is a brief introduction of these modes.

Normal Mode (Default mode)

Normal mode is the default mode of operation and the one you will use most of the time. Use this mode

for more tasks and configurations. Programs also are executed in this mode.
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Safe Mode

Safe mode is a trouble shooting. The mode loads the minimum required device drivers and system
services to boot the WP-2000-CE7.
If you have malicious software or a program caused the WP-2000-CE7 cannot be boot or run the normal

mode, you can boot in safe mode to solve the problem.

Debug Mode

Debug mode is a special environment in which program debug functions can be used in addition to
normal system functions.

Debug mode is unsupported.

OS Update Mode

OS update mode is a way used to update OS. For more information on updating the WP-2000-CE7 OS

image, please refer to section 6.1. OS updates

Reserve — OS Development Mode

The positions 4, 6, of rotary switch are reserved for OS development.

User Mode

The positions 7, 8, 9 of rotary switch are reserved for user’s applications.
When WP-2000-CE7 is boot with one of these positions, it is boot at normal mode. User’s application

can check the position of the rotary switch position to run at different mode.
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2.4. Using PAC Utility to Manage WinPAC

The PAC Utility is a collection of the WinPAC system tool that allows user quickly and easily manage and

configure the WinPAC.

For more detailed information on PAC Utility applications, please refer to “3.1. PAC Utility”

Step 1: Double-click the PAC Utility on the desktop

Double-click the
PAC Utility shortcutJ

Step 2: Configure IP address (DHCP), FTP Server, Auto Execution files..., etc

[Gemeral I General2 I Display I 1P Config ‘ Netwark |DEVHZE! Infor mation IAutD Execution I Rotary Exd ol I 3
Access | Login
FTP @ Enable () Disable

Allow Anonymols @ Enable () Disahle

Set FTP default download directory to:

F )] e |
Browse for Folder
Iy Device
Metwork
SetHTTP do| . Systam_disk
\windowsiw| - Recycled Apply
Application Data
Iy Recent Docurnents
My Documents
Prograrm Files
Windoas
Cancel | Ok

Step 3: Reboot the WP-2000-CE7

Save
Save and Reboot
Reboot
Restore Utiity Default Settings
Exit
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2.5. Changing the User Interface Language

The Windows CE operating system on the WP-2000-CE7 comes with several built-in functions.

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional Settings Options

Jj Prograrns ’
'{:‘? Faviorites r
D Documents
- Settings B Control Panel

‘i}, Metwork and Dial-up Connections

E Taskbar and Start MenL...

\

Feqgional
Settings

Regional and Language Settings

Regional Settings User Interface Language I Input Language |

-Your locale

The locale option affects how some programs format numbers, currency,
time and dates.

—rnglich (Lnited States) Customize...
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Step 2: Click User Interface Language tab, choose to your local language, and then click OK

Regional and Language Settings m

| Regional Settings | User Interface Language | Input Language |
-User Interface Language

The option will determine the language used for the menus, dislogs
and alerts,

Erglish (United States) EI

ish (nited States)
French (France)
German (Germarny)
Italian (Ttaly)
PortugLese (Brazil
Soanish (Spain - International Sort)

Step 3: Run the PAC Utility, and then reboot the WinPAC for changes to take effect

Reboot
. Restore Utility Default Settings
PaC Tt Exit
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2.6. Using DCON Utility Pro to Configure 1/0 Modules

DCON Utility Pro enables users easily to configure and manage the I/0O modules via Ethernet or serial
ports (RS-232/RS-485).

Step 1: Double-click the DCON_Utility_Pro on the desktop

.8

Double-click the
DCON__Utility Pro
shortcut

v

il

Step 2: Click the button

ity Pro 2.0.0.0 for CE7 arm{WP5231)

mlll]

= dress D End Address 1

|Addr... |Baud Rate |Checks... |Format|5tatus |Description

o

4
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Step 3: Configure the communication settings

COM Port Option
COM Port Timeaolt
COMO[Backplane] - |200 | ms
COML |
COMD lare] ecksum | Format
COM3 —————J |
COom2
COM4 2 OEst Q081
OK Cancel

Tips & Warnings

Q The COM port settings for expansion I/O modules are listed below.

Mg

COMO[Backplane] «
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Step 4: Click the

button

D |Add..

End Address 1

IBaud Rate IChecks IFormatlstatus IDescription

4

Step 5: Click the module name to configure the 1/0 module

DCON Utility Pro 2.0.0.0 for CE7 arm({WP5231)

=tort Address

El End Address 1

| Baud Rate I Checks

1o |Format|5tatu5 |De5cription
1|T Disable  N,8,1

XV107 Firmware[0100]

[Modbus RTUS*DI + 8*0d]

| configuration D0 {HostwoT | o1 | o1 Lateh | o1 counter | about |
DO Status
Mo [r [Tz [z [1a [Js [Js []7
q O Read Powsr OM Yalue
| Set Safe Vale | (") Read Safe walue
COM:O[MN,E,1] |
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2.7. Using Dial-up Networking to Make a GPRS Connection

(for Mobile network expansion card had installed)

The Windows CE dial-up networking component driver can be efficiently used to include support for

transferring data over GPRS modems in WP-2000-CE7

Step 1: Click Start menu, point to Settings, click Network and Dial up Connections, and then click Make

New Connection

) Programs  *
¢ Favorites  »
) Documents *

g [ Contral Panel

2 Run...

J
PCI- PCIL- <
FETCESEL FETCESE2 ™3

Step 2: Type the name of the connection, select the Connection type as the Dialup connection, and
then click Next button

Make New Connection
Type a narme for the connection:

et |
_‘-.-:@I_ IM\; Connection

Select the connection type:
(@) Dial-Up Connection
() Direct Connection
{7 Wirtual Private Metwork (PPTR)
() virtual Private MNetwork (L2TP)
() PPR aver Ethernet [PPPoE]
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Step 3: Select USB Modem as a modem diver in the select a modem option and then click Configure
button

My Connection Properties

Madem | Phone Mumber |

_l_*f-'j?l My Connection

Select a modern:

:ISE Modern

| ICP{IP Settings... | Security Settings... |

Step 4: Select 115200 in the Baud Rate option and click then click OK button

Device Properties
Port Settings |Ca|| Ciptions |

r Manual Dial {user supplies dial
strings )

15200

before dialing Stop Bits Il ]

r Lise terminal window after

dialing Flowe Control IHardware :I

Terminals = —
[ Use terminal window Barity IND”E E

Step 5: Select Call Options tab, enter the modem dialing settings in the commands field, and then click
OK button

The modem dialing settings depends on each of the telecom company. For example, the
settings provided by Telecom Company in Taiwan is

+CGDCONT=1,”IP”,”INTERNET”
and a Telecom Company in China is

+CGDCONT=1,”IP”,”CMNET”

Device Properties m

Call Setup
Cancel the call if not connected within 120 seconds
Wait for dial tone before dialing

Wait for credit card tone |0 seconds

Extra S . \special rmodemn cornrmands may be inserted i Jial string)
+CGOCONT=1,"TP", "INTERNET"
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Step 6: Select Phone Number tab, enter the phone number settings in the Phone number option, and
then click OK button

The phone number settings should fit the Telecom Company’s setting. For example, the
following setting is for Telecom Company in Taiwan.

My Connection Properties m
Phane Number
é}l My Connection

Countryfregion code; |

—

Area code: T

Phone nummber: I*QQ***l#

[ Force long distance
[ Force local

Step 7: Double-click the new connection that you have created, and enter the User name and
Password, and then Click Connect button

File Edit»~ snced || X 2e -
=1 ¥ -
& L E
Make M\ M2 LAM1
Connectic
Dial-Up Connection
21
|
User Mame: Iguest ’ Pl Ok |
Password! ] N
Darmal i, __‘ \ Y/ Dial Properties. ., |
[ Save password — |
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Step 8: Wait for the connection to be established

U200 Status
-‘f}l Connected

Hide this rnessage:

Disconnect

Tips & Warnings

Q If the connection fails, as shown below, please repeat the instructions to view the settings.

Remote Networking

;
i ! E The port is not available; another program may be using it.
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3. Tools and Tasks

This chapter provides a brief introduction of the WP-2000-CE7 service tools and its benefits.

There are several tools and utilities built-in and designed for use with WP-2000-CE7. Some of these are
pre-installed on WP-2000-CE7 and can work directly on WP-2000-CE7, and some of these are supporting
tools and can help you to manage the WP-2000-CE7 remotely on a PC.

The following tools are pre-installed on WP-2000-CE7 and can work directly on WP-2000-CE7 that can be
found by downloading the latest version from ICP DAS web site.

https://www.icpdas.com/en/download/show.php?num=2346

Tools

DCON_Utility_Pro

ISQLW35

modbus_master_tool

Notepad

PAC_Utility

RegEdit

Remote_Display

SendToCOM

TaskMgr

VCEP
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The following tools are supporting tools for remote managing the WP-2000-CE7 used on PC that can be
found by downloading the latest version from ICP DAS web site.

https://www.icpdas.com/en/download/show.php?num=2083

Tools

E— Eshell
— Remote_display_application

Tl Tools
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3.1. PAC Utility

PAC Utility is a collection of software applications that enable management and configuration of WinPAC

system and features.

PAC Utility [1.2.0.5] ! E

GEHEI’E|| Display I IP Canfig I Metwiark I Device Infarmation I Autn Execution IRDtary Execution |

Witelcome fo use PAC Utility
This ool will help you easy to
Lise PAC CE series,

PAC Utility

Task Bar setting:
[ Auto Hide

[ &lways On Top

HIVE Registry:
@ Auto Save To Flash (Default

(" Maunal Save To Flash

Backplane Battery [[] Enable sutorun in plugging USE Disk
Batteryl : Battery2 :
Configure the synchronization with 3 time server | Configure

The PAC Utility includes the following menu bars and property tabs. All of these functions will be

explained later.

‘ Menu bar | Property Tab ‘
* File * General
* Help * Display
* |P Config
* Network

® Device Information

* Auto Execution

* Rotary Execution
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3.1.1. Menu Bar - File

Save
Save and Reboot

Restore Utility Default Settings

Exit
‘ The menus use to ’ How to use
Reboot Restarts the WinPAC
Restore Default Settings Restore the settings of WinPAC to its default.
Exit Exits the PAC Utility.
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3.1.2. Menu Bar - Help

About PAC Utility

PAC Utility

PAC Utility
Yersion: 1.2.0.3

Copy Right (c) 2005, ICFDAS Co., LTD.
All Rights Reserved. PAC Litility and the
PaC Utility logos are trademarks of
ICPDAS.

FAC {windows CE; en-US)

The menus use to How to use

About Displays a dialog box with information about PAC Utility,

including the current version and copyright information.
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3.1.3. Property Tab - General

The General tab provides functions to configure the task bar, check the status of the battery..., etc.

PAC Utility [1.2.0.6]

File Help

Backplane Battery
Batteryl

Configure the synchronization with a time server |

Welcome to use PAC Utility
This ool will help you easy o
use PAC CE series.

Taszk Bar setting:
[ &uta Hide
[ &bways On Top

HIVE Reqistry:

[] Enable sutorun in plugging USE Disk
[] Enable &utorun in plugging Micro SO

Configure |

The tab use to ‘ How to use

Lock or Auto-Hide the taskbar

Auto-Hide:

Select the Auto Hide check box.
Lock:

Select the Always On Top check box.

Auto save or manual save to flash

By default, these options are unavailable.

Auto save to flash:

This option is checked by default.

Any changes made to the WP-2000-CE7 will be saved and only
take effect after the WP-2000-CE7 reboots.

Manual save to flash:

This option is useless.

Check the status of the battery

See the Batteryl field that displays the display resolution.

Automatic synchronization of

system time

Refer to the Appendix A.2. How to Automatically Synchronize

WinPAC Clock with an Internet Time Server.
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3.1.4. Property Tab — Display

The Display tab provides functions to configure the monitor settings.

PAC Utility [1.2.0.6] ! E

Screen resolution: 800 x 600 Screen refresh rate:
Less U More 70 EI

800 by 600 pixels

The tab use to ‘ How to use
Adjust the screen Move the slider to the left to decrease the resolution or move the slider
resolution to the right to increase the resolution, and then click the Apply button.
Change the screen Select the desired refresh rate from the Screen refresh rate drop-down
refresh rate list, and then click the Apply button.
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3.1.5. Property Tab — IP Config

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured (Static)
network settings and to monitor the MAC address. Generally, DHCP is the default settings, but if you

don’t have a DHCP server, you must configure the network settings by using manual configuration.

PAC Utility [1.2.0.6] _I0

LANM 1:

MAC Address: 7B8-C5-ES-88-96-8C
(@ Use DHCP to get IP address
() assign IP address

IF Address: |1E|.1.EI.EIE|

Mask: |255.255.EI.EI

Gateway:  [10.1.0.254

DS Server: |1D.IZI.IZI.3

[ Reboot far changes to take effective

[ thowbuseto | owtowe

Use DHCP to get IP address:

Select the Use DHCP to get IP address option, and then click the Apply
Set the network
button.
settings
Assign an IP address:

Select the Assign IP address option, and then click the Apply button.
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3.1.6. Property Tab — Network

The Network tab comprises three tabs — Access, Login and File Server Settings.

Access

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous FTP

access, and configure the FTP and HTTP directory path.

PAC Utility [1.2.0.6] ! E

[General Display IIF' Config ‘ Metwork | Device Information Iﬁub:u Execution IRDtary Execution |

Ef-‘tEEESS Login IFiIe Server Settings |

FTP

Allow snonymous @ Enable (") Disahle

Set FTF default download directory to:

(@ Enzhle {) Disahle

WTemp || || Apply
Set HTTF docurment root directory to:
v indoweswrastiarwnesib || || Apply

Enable or disable

the FTP access

Enable:
Select the Enable check box in the FTP field, and then click the Apply button.

Disable:
Select the Disable check box in the FTP field, and then click the Apply button.

Enable or disable
anonymous FTP

access

Enable:
Select the Enable check box in the Allow Anonymous field, and then click the
Apply button.

Disable:
Select the Disable check box in the Allow Anonymous field, and then click the

Apply button.
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The tab use to How to use

Set the FTP Enter a new path in the Set FTP default download directory to: field, and then
directory path click the Apply button.

Set the HTTP Enter a new path in the Set HTTP document root directory to: field, and then
directory path click the Apply button.

Login

The Login tab provides functions to maintain the FTP accounts.

PAC Utility [1.2.0.6] M (=]

File Help

[General IDiSpIay IIF' Config | Metwork | Device Information I.-'-‘-.LJDII Execution I Rotary Executian |

[ﬁccesa | Login | File Server Settings |

Lser Name Fassword

licroas | | Add ]| Delete
Liser narne I Fassword I
ICPDAS o

The tab use to How to use
Maintain the FTP Refer to the Appendix C.1 How to add a user account to remote login the
accounts WinPAC from PC.
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File Server Settings

The File Server Settings tab provides functions to set the SMB server.

PAC Utility [1.2.0.6] ! E

[General I Display IIP Config | Metwork | Device Infar mation Iﬁub:u Execution IRDtary Execution |

ACCESS I Lagin | File Server Settings |

fou can create a networked file server and enables clients 1o store and
retrieve files, and makes use of the Internet for communication between
client devices and other shared equipment.

i JII Settings
E 1B Share Files System Settings !

Device Mame {Each device need setting
a different device name)

|C|:| rpact |

The path to the folder to be shared

e ]

Configure the file server to use Lalx as
the network adapter

|cPewiaGt vl

Enable all authentication on the file
server, The file server will not be
accessible to all users on the

network and the "admin" as the
user to be allowed access to the
file server

Set

Help

The tab use to

Set the SMB server Click the Settings button to set the SMB server path.
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3.1.7. Property Tab — Device Information

The Device Information tab provides functions to monitor necessary system information of the WinPAC.

The information is the most important note of version control for upgrading system.

PAC Utility [1.2.0.6]

File Help

General ] Display ] IF Config ] Metwork | Device Informatian l AL Execution | Rotary Execution ]

slott: [ ] CPU Type: [wPs23x |
Slotz: [ ] Serial Number: |p1-s8-2c-1F-16-00-0020 |
Slat 3 I:I Backplane Version: |fo-‘~ |
Slot 4 |:| CPU Version: [z |
Slot 5 |:| 0S version: [1005 |
Sote: [ ] Ebootversion: 52525 |
Sot7: [ ] METCF Version: [3.5.7338.00 |

SOL CE ersion: |2.5.8154.0 |

PACSDK Version: 4321 |
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3.1.8. Property Tab — Auto Execution

The Auto Execution tab provides functions to configure programs running at WinPAC startup, it allows

users to configure ten execute files at most.

Tips & Warnings

Q The specific extensions are .exe and .bat, and they are executed in order of program 1,

program 2, etc.

PAC Utility [1.2.0.6]

[General IDiSpIay IIF' Config I Metwork IDevice Information | AUt Execution |Rc|tarﬁ,r Execution |

Program 1: |‘-53rstem_Disk1TDDIsWu:epw_rethe.exe || Browse |

Program 2: |Eystem_Diak\TDDIs\FAC_Utilit:.r\FAC_Utilit:.r. || Browse |

Prograrm 3. | | | Browse |
Prograrm 4: | | | Browse I
At m;at 10 p;ugr:jms FrogramS: | || Browse |
can be specifie .
execute automatically Fie 2RI ) | | | Browse |
at systerm startup, Program 7: | | | ym— I
Frograrm 8: | | | Browse |
Prograrm 9: | | | Browse I
Programl0; | | | Browse I

The tab use to How to use

Configure programs Click the Browse button to select the execute file which you want, and

running at startup then click the Apply button.
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3.1.9. Property Tab — Rotary Execution

The Rotary Execution tab provides functions to configure programs running at WinPAC startup in one of

the user defined mode, it allows users to configure ten execute files at most.

PAC Utility [1.2.0.6] M (=}

[ General IDiSpIay I IP Config I Metwark I Device Infarmation I ALto Execution | Rotary Execution |

Rotary Switch 0 ‘Nnrmal Mods | | Erowse |
Rotary Switch 1 |Safe Mode | CErowse |
Rotary Switch 2: ‘Debug Aode | | Browse |
Raotary Switch 3: ‘OS update mode by Ethernet | | Browse |
Rotary Switch 4: ‘Reserued | Bronwse |
Rotary Switch 5: ‘OS update made by Micra_SD | | Browse |
Rotary Switch &6 ‘Regerued | | Briomse I
Rotary Switch 7 ‘ | | Browse |
Rotary Switch 2: ‘ | | Browse |

Rotary Switch 9; | | _Browse |

The tab use to How to use

Configure programs running at startup | Click the Browse button to select the execute file which you

in one of the user defined mode want, and then click the Apply button.
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3.2. DCON Utility Pro

DCON Utility Pro enables users easily to configure and manage the I/0O modules via Ethernet or serial

ports (RS-232/RS-485).

For more detailed information on how to use DCON Utility Pro to configure I/O modules, please refer to

“2.4. Using DCON Utility Pro to Configure I/0 Modules”

DCON Utility Pro 2.0.0.0 for CE7 arm{WP5231)

Start Address EI End Address

I |deu:lr... |Baud Rate |Chet:k5... |Format|5tatua |De5cription
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3.3. TaskMgr

The TaskMgr is a Windows CE application, which provides real time info on all processes and threads

including System threads, similar in appearance to the Windows Task Manager.

Windows CE Task Manager

Performance IPI‘DCESSES Ij-app]jcaticu 1 n
100

Windows CE Task Manager

Lpplicatio n u

Procesaes

Irviage Marm... | Threa... | Llern, | &
TaskIvlanager.e -
_remnte exe wWindows CE Task Manager
gervicesd exe hpplications | Disk Net
Usage 2% explorer.exe
Gaellzer e Task |
—_—| | udeviceee (%]
udevice gxe YV Virtual CE
NE BYE
<
|
d | B
Close Swritch
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3.4. VCEP

ICPDAS VCEP is designed for managing your WinPAC anywhere. No matter where you are, ICPDAS VCEP

provides a convenient environment on the Desktop PC and lets you control your WinPAC remotely.

ICPDAS VCEP is composed of two main components: The “Server” which runs on WinPAC and the ‘Client’
which runs on a Desktop PC.

Once a connection is established between the client and server (initiated by the client), the client will
periodically send requests for screen updates and send mouse/key click information to the server to
simulate.

Each video frame is inter-compressed against the previous frame and then intra-compressed with a

modified LZW scheme to minimize the amount of data transmitted from server to client.

For more detailed information on VCEP application, please refer to

http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x ce50/pc tools/vcep 5.0.0.0/
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3.5. Remote_Display

The "Remote Display" allows WinPAC to be controlled and monitored from a remote location. This tool is
composed of two parts, a client and a server. The server is a program named cerdisp.exe running on

WIinPAC. The client is a PC-based program named cerhost.exe running on the PC.
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3.6. SendToCOM

The SendToCOM uses the serial port to communicate with expansion module. To use the SendToCOM,
you can send data to expansion module through the serial port, and receive data from other device

through the serial port.

For more information about these commands for communicating with expansion module, please refer
to:

http://www.icpdas.com/root/product/solutions/remote io/rs-485/i-8k i-87k/i-8k i-87k selection.html#
b

ICPDAS Send to COM V1.0.4 2011223
Connection Skatus
COM Port Baudrate [rata Bik Parity: Stop Bit Slak
|COM2 | |115an | IE :I ID-Nnne Patity :| |1 :| | :|
Endstringwith @ mone (JLFcR (YR (CRIF (OLF [string | B4 +cre

Commands Responses ) EBinary (@ String Palling

Current Packet Size (bytes) |p Current Packet Size (bytes) Auka send Internal ims)  [5op
Total Packet Evtes o Total Packet Bytes o | e | | Stop I Set
Packet Quantity send n Packet Quantity received |0 Start Time |Start Time

ﬂl Stop Time  |Stop Time

Clear
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3.7. RegEdit

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in
appearance to the Windows Registry Editor. The standard registry roots are represented; you can add
keys beneath a root to point to existing registry keys, or you can add your own keys. Values can be
changed for existing keys, or added for new keys, and default keys can be specified. For more

information, see Registry Settings Management in Deployment.

Marme I Type I Data I

B HKEY_LOCAL_MACHINE
. HKEY_UUSERS
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3.8. 1SQLW35

The "ISQLW35" is a Windows Embedded Compact 7 functionality that implements SQL Server Compact
3.5 Query.

soL | [ arid Mates

Tools 501 | [ 1 U X
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3.9. INotepad

The INotepad is a common text-only editor. The resulting files have no format tags or styles.

INotepad ! E
File Edit Format Help

s
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4. Your First WinPAC Program

This chapter provides a guided tour that describes the steps needed to set-up a development

environment, download, install, configure for user programming with the WP-2000-CE7.

Before writing your first program, ensure that you have the necessary development tool and the

corresponding WinPAC SDKs are installed on your system.

Development Tools

WP-2000-CE7 series modules are Windows CE-based units. Windows CE is a mature embedded

operating system which supports rapid development.

The table below lists the supported development tools and development languages to develop

WP-2000-CE7 applications.

Development Tools

Languages

\E]

Basic.Net

Visual C#

Visual C++

Visual Studio 2005

Any versions except

Professional

or earlier

Professional

Visual Studio 2008

Any versions except

Professional

Professional \4 V v
Any versions except
Visual Studio 2012 . - - -
Professional
or later
Professional - - -
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4.1. Preparing the Development Tools

WP-2000-CE7 is a Windows CE-based unit. Windows CE is a mature embedded operating system which
supports rapid development. The standard development tool is list as follows which is highly integrated,

with comprehensive support for developing applications of Windows CE-based WP-2000-CE7.

>  Visual Studio 2008

Microsoft* ‘ ;

Visual Studio 2008

WP-2000-CE7 has .NET Compact Framework 3.5 installed. Visual Studio 2008 takes full advantage of
the .NET Compact Framework, which uses public Internet standards to enable integration with new
and existing applications running on any platform. Supported languages include Visual C#, Visual C++

and Visual Basic .NET.

Installation Steps:

1. Visual Studio 2008 Professional
Purchase from MSDN subscription

Microsoft DreamSpark: https://www.dreamspark.com/Product/Product.aspx?productid=1

2. Visual Studio 2008 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986

3. Visual Studio 2008 update for Windows Embedded Compact 7

http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935

4. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1

http://support.microsoft.com/kb/2468183/en-us
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4.2. Installing WP-2000-CE7 SDK

The WinPAC SDK is a Software Development Kit (SDK) that contains C header files, C libraries and

documents.

Step 1: Get the latest version of the installation package file

The installation program for the latest version of the WinPAC Platform SDKs can be
obtained from:
https://www.icpdas.com/en/download/show.php?num=2409

File name: PlatformSDK.zip

Step 2: Unzip the archive file, and then execute the installation package file
“AM335x_WINCE7_SDKVxxxxx.msi” and the
“VisualStudioDeviceWindowsEmbeddedCompact7.msi”

ools | Test Window Help

Sk Attach to Process... Cl+AlHP
Step 3: Execute any VS2008 C++ project include the , . .
83 | Device Security Manager...
AM335x_WINCE7_SDK(ARMv4I) platform and the BB Conwectio Degice..

click the “Tools”->"Options...” 8f  Device Enmlator Manager...

":"_J; Comnect to Databage...

"2.' Comect fo Server...

) Code Snippets Manager.. CtlK, CtltB
Choose Toolbox [tems...
Ldd-in Manager. .
Macroz

Find More Extensons...

Create GUID
Diotfuscator Comumunity Edition
Error Lookup

L TLMMFC Trace Toaol

Sport

Visual Stodio 2005 Comnand Prompt
=% WCF Service Confignratinn Editer

External Tonls. .

Import and Export Settings. ..
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Step 4: Click the “Projects and Solutions”->"VC++ Directories” and then select the

“AM335x_WINCE7_SDK (ARMv4I)” ~ “Include files” at “Platform:” and “Show directories for:”

item

s —— .

+- Enviromnment

£ latform: Show directories for:

= Projects and Solutions AW 335 WINCE? 3DE (ARM» | | Include files w
Creneral
Bnild and Eun o -
¥E Defanlts — . *
WC++ Directories SV ClnstallDir)ce Pdnclude
W C++ Project Settings $WCInsbaJJDjI)ce?‘s&tlmfc'\imlude

¥ souice Contral $WCIHS1BJJD1¥)CE"JH_E1U119 )

+ Text Editor CAProgram Files\Windows CE ToolsSDESLM 230 WINCET_SDE\nclud eh

Datshase Tools CAProgram Files\Windows CE ToolsSDE\MM335x WINCE?_SDEMnclude

- CAlahae oo B0V ClnstallDir)cetatlmciineTude

+- Debugzzing $ (V3 TnstallDir) SmartDevices SDESOL ServertMobilew 3 0

+- Device Tools

+- HTML Designer

+- Office Tools

#- Test Tools < >

: Eﬂfﬂiﬁﬂ%ﬁﬁ Diesigner Include Directories . . . o .

 Workflow Desiensr Path to g when sarching for include files while building a WC+4+ project.

Comresponds to enviromment variable INCLUDE.

[ ok || Cancel |

Step 5: Add the path “$(VCinstallDir)ce7\include” and “$(VCinstallDir)ce7\atimfc\include” and then
click the OK button.

FIATOTm BTN QATECTOTEES TOT:
AM335x WINCET EDE (AREM+ » | |Include files w
| e x|+ +|
BV CInstallDirhce Pinclode
SV CInstallDivice Taflmtc\include
BV CInstallDivhcetinelud e

CAProgram Files\Windows CE Tool\SDESMM 335 WINCET _SDEMnclodeh!
CAProgram Files\Windows CE Tools\SDESMMM 3350 WINCET _SDEMncInde
$0¥ CInstallDiviceatlmfchinend e

5O ATt 1D S martDeyviced S DESOL ServerMobile'w 3.0

Tips & Warnings

Q The path “S$(VCinstallDir)ce7\include” and “S(VClInstallDir)ce7\atimfc\include” must be on
the top of box.
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4.3. First WinPAC Program in VB.NET

The best way to learn programming with WinPAC is to actually create a WinPAC program.
The example below demonstrates how to create a demo program running on WinPAC with VB.NET.
To create a demo program with VB.NET that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference
3. Add the control to the form

4. Add the event handling for the control
5. Upload the application to WinPAC

6. Execute the application on WinPAC

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-2000-CE7 SDK on PC and used the Visual

Studio 2008 for application development.
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4.3.1. Create a New Project

The Visual VB.net project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

D

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » | 5] Project. Cirl+Shift+N

Open » | @ WebSite.. Shift+ ALt+N

Close ] Eie.. Chl+N
Project From Existing Code...

@ Save Al Cl+Shaft+S

Recent Files >
Recent Projects >
Exit
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Step 3: In the Project types pane, expand Visual Basic, and then click Smart Device

Step 4: In the Templates pane, click Smart Device

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish

New Project E]

| NET Framework 3.5 v|EI!El

Project types: Templates:
[=)- Vizual Basic Yizval Studio installed templates
W indoves Fp A
Web Jfel#mart Device Project
Smart Device
Office
Databaze Mmpl&tes
Reporting
Test
WCE
Workflow
Vimmal C#
Viznal C++
Other Project Tvpes
Test Projects

i mearch Onling Templates...

|£L project for Bmart Device applications. Choose target platform, Framework version, and template in the next dialog box. |

Narme: | SDEInformation |
Location: |C:'\Documents and SethngshWindowsby DocomentsWh_Windowsd My Documents w | Browss...
Solution Name: |SDKIn.fDnmI:iJ:nn | Create divectory for solution

[ oK [ Comcel |

Tips & Warnings

A The WCE7 only support .NET Compact Framework Version 3.5, if your application uses .NET
Compact Framework Version 2.0 there is no guarantee that the program will function

correctly.
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Step 6: In the Target platform item, choose Windows CE

Step 7: in the .NET Compact Formwork version item, choose .NET Compact Framework Version 3.5

Step 8: in the Templates pane, choose Device Application, and then click Next

Add New Smart Device Project - SDEInformation

Target platform: | Windows CE b |
NET Compact Framework version: | NET Compact Framework Verson 3.5 b |
Templates:
& W g g B
g | Description:
Clazs Library Console Control - Empty Project 4 project for creating a NET
Application Library Compact Framework 3.5 forms
application for Windows CE
Flatform

Download additonal exolator images and smart device SDEs.

OK || Cangel
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4.3.2. Specify the Path of PAC Reference

The PAC SDK provides a complete solution to integrate with WP-2000-CE7 and it’s compatible with Visual
C#, Visual Basic .net and C++. In order to use a component in your application, you must first add a

reference to it.

Stepl: Get the PACNET.dIl and copy it to the project folder

The PACNET.dIl can be obtained from the link below that has been provided by
downloading the latest version from ICP DAS web site.

https://www.icpdas.com/en/download/show.php?num=2409

PACNET ALl
w7 244091
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Step 2: In Solution Explorer, right-click the References node, and then click Add Reference...

Solntion Explorer - MyPorject

@ 2] [ E &

(o Solution MyPorject' (1 project)

Febuild
Deplay
Clean

Add »

Add Reference. .,

Add Web Reference, .,
e Clazs Diagram
Setaz Startllp Project

Debug ]

Cut

Remoaye

Rename

nload Project

Qpen Folder in Windows Explorer
Change Target Platfonm...

Properties

LE] Eesource View |l:g Solution Explorer :2% Clazs View
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Step 3: Select Browse tab and add the PACNET.dII

Add Reference

| NET | Projects ’ Browse |Recent |
Location: | [ SDEInformsation VI 3 2 E®E-
)b
() My Project
()obi
EYPACNET.A0
Hame: PACNET 4l v
File types: JCompom:nt Files (*d1;* tlb;* olb;* ocx;* exe) w ’
[ o || Cawel |
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4.3.3. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; they

are just images that are convenient to move around on the form into a precise location.
After you add a control to your form, you can use the Properties window to set its properties, such as

background color and default text. The values that you specify in the Properties window are the initial

values that will be assigned to that property when the control is created at run time.

Step 1: From the Toolbox, drag a Button control onto the form

Toolbox
= All Device Controls ~
R Pointer

227 BindingSource |
l Button | 1 ‘
CheckBox

: H x*
=% ComboBox SDKInformation* ' Forml.vb [Design]* ~ Start Page

1 DataGrid

29| DataSet

T Date TimePicker

[ DomainUpDown

<3 H¥crollBar

=7l ImageList =
% Server Explorer |35 Toolbox |

4
X

= maindenul

WP-2000-CE7 Series (WinCE7 Based) User Manual v1.04 Page: 74



Step 2: Right-click the Button control, and then click Properties

SDKInformation* ' Forml.vb [Design]*  Start Page ¥ X
A
maIE
Yiew Code
Ering to Front
Send to Back
@ Lock Controls
Select Forml'
#  Cut
=3 Copy
o v
& | % | Delete P
= mainMenul 2 Properties

Step 3: In the Properties window, type Check the SDK version, and press ENTER to set the Text
property

Buttonl Syvstem. Windows Forms Button -
2L [5]

BackColor [] Control
Font Tahoma, 10pt

ForeColor - ControlText

Check the SDK Version v,
=] A¥101

ContextMenu (none) >
Text
The text contained in the control.
'_73[:1::«_:-:-.*\; Fiew ijﬁl’mperﬁzs [
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4.3.4. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start adding

some code to provide the program's functionality.

SDKInformation* ~ Forml.vb [Design]* ¥ X
N
6
c 'm}
Step 1: Double-click the button on the form & Check the SDK Version
o o al
v
< >
= maindenul

Step 2: Inserting the following code

Dim data(30) As Byte

PACNET.Sys.GetSDKVersion(data)
MessageBox.Show(PACNET.MISC.WideString(data))

oPublic Clazs Forml

Private 3ub Buttonl_Click(BvVal sender As Svatem_Object, BvWal e 8z Svstem Eventdrgs) Handles Buttonl .Click
Dim dataf30) A= Byie
PACHET Evztem . GetilEVersionidatal
MezsageBox Show(PACMET MISC WideString(data))
End Zub
End Claszs

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.

WP-2000-CE7 Series (WinCE7 Based) User Manual v1.04 Page: 76



4.3.5. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a public FTP

server.

Step 1: On the Build menu, click Build SDKInformation

File Edit Yiew Project Debug Tools Test Window Help
" Build Solution  Ctl+Shift+B

| Rebuild Solution

Deploy Solution

Clean Solution

Build SDKInformation

Rebuild SDKInformation

Deploy SDKInformation

Clean SDKInformation

Project Only »

Batch Build...

: Configuration Manager...

|2 Compile Ctr4F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKinformation.exe application and the corresponding PACSDK.dIl and PACNET.dII
files to WinPAC

Tips & Warnings

For applications programming in C# and VB.net with .net compact framework, when
A executing these application on WinPAC, the corresponding PACSDK.dIl and PACNET.dIl must

be in the same directory as the .exe file.

File Edit View Go Favorites |||]][

[I]ﬁgdress | vTernp

) & O

PACcHNET.dI
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4.3.6. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

™

EhKinformat:
L ONeRe
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4.4. First WinPAC Program in Visual C#

The best way to learn programming with WinPAC is to actually create a WinPAC program.
The example below demonstrates how to create a demo program running on WinPAC with C#.
To create a demo program with C# that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference
3. Add the control to the form

4. Add the event handling for the control
5. Upload the application to WinPAC

6. Execute the application on WinPAC

All main steps will be described in the following subsection.
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4.4.1. Create a New Project

The C# project template is a composite control that you use in this example creates a new project with

this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

D

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » | 5] Project. Ctel+-Shift+N

Open » | @ WebSite.. Shift+ ALt+N

Close ] Eie.. Ctl+N
Project From Existing Code...

@ Save Al Cl+Shaft+S

Recent Files >
Recent Projects >
Exit
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Step 3: In the Project types pane, expand Visual C#, and then click Smart Device

Step 4: In the Templates pane, click Smart Device

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish.

New Project

Project types: Templates: HNET Framework 3.5

JmE

Vimal Basic Yisual Studio installed templates
(=) Vimal C# s
Windowes ESmart Device Project
Web
Simart Device
Office
Databasze
Reporting
Test
WCF
Workflow
Vizual C++
Cither Project Tapes
Test Projects

My Templates

o earch Omline Templates. .

|£L project for Smeart Device applications. Chooss target platfonm, Framework version, and template in the next dislog boo,

Waume: | SDKInformation |

Solution Name: |SDKInfnnnatinn | Create directory for solution

Location: |C:'\Docu.menis and. Settings\Windows\hy Documents\Whi_Windowsd My Documents Ev | Browss...

ok JI

Caneel ]
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Step 6: In the Target platform item, choose Windows CE

Step 7: in the .NET Compact Formwork version item, choose .NET Compact Framework Version 3.5

Step 8: in the Templates pane, choose Device Application, and then click Next

Add New Smart Device Froject - SDEInformation

Targst platform: | Windows CE v
HNET Compact Framework version: | NET Cornpact Framework Verson 3.5 w |
Templates:
@ @ |25
) = Dlescription:
Control Empty Froject A project for creating 2 NET
Library Cormpact Framnework 3.5 formms
application for Windows CE
Platform

Download additonal emulator imases and smart device SDEs.

[ oK [ Cancel

Tips & Warnings

A The WCE7 only support .NET Compact Framework Version 3.5, if your application uses .NET
Compact Framework Version 2.0 there is no guarantee that the program will function

correctly.
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4.4.2. Specify the Path of PAC Reference

The PAC SDK provides a complete solution to integrate with WP-2000-CE7 and it’s compatible with Visual
C#, Visual Basic .net and C++. In order to use a component in your application, you must first add a

reference to it.

Stepl: Get the PACNET.dIl and copy it to the project folder

The PACNET.dIl can be obtained from the link below that has been provided by
downloading the latest version from ICP DAS web site.
https://www.icpdas.com/en/download/show.php?num=2409

File name: PACNET.zip

PACHET A1k
0724491
PACIET

.............................
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Step 2: In Solution Explorer, right-click the References node, and then click Add Reference...

Solution Explorer - SDKInformation

2 | » 7] EE &

"o Solution SDKInformation’ (1 project)
& .;g-'_‘] SDKlnfo: ‘
@ 4 Proper] (£ Buid

# - =a] Refere Rebuild
= 2] Forml
%) Fo Deploy
®) Fo Clean
] Pro
_] L Add »
Add Reference...

Add Web Reference...
&% Yiew Class Diagram

Set as StartUp Project

Debug »
& Cut

b

X Remove
Rename
Unload Project

() Open Folder in Windows Explorer
Change Target Platform...

T

‘s Properties

a Resource Yiew | QSdluﬁon Explorer ,:F; Class View |
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Step 3: Select Browse tab and add the PACNET.dII

Add Reference

| NET | Projects | Browse |Recent I

Loeation: ‘@SDKlnfonmﬁun Vi % 5 Rk FEF b
) bin

() My Project

(=) obi

PACNET.d

Hame: PACNET.AN v

File types: ‘Componmt Files (*d1;* flb;* olb;* ocx;* exe) W |
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4.4.3. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; they

are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such as
background color and default text. The values that you specify in the Properties window are the initial

values that will be assigned to that property when the control is created at run time.

Step 1: From the Toolbox, drag a Button control onto the form

= All Device Controls ~
R Pointer

iij Bindinglource

] Button ‘
CheckBox

=% ComboBox Form1 .cs [Design]* " Start Page | Object Browser v X
RE| Contextienn
1 DataGuid

27| DataSet

7 Date TimePicker
[ DomainUpDown
<3 H¥crollBar

=) TmageList v v

% Server Explorer |35 Toolbox |

= mainMenul
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Step 2: Right-click the Button control, and then click Properties

Form1 .cs [Design]*  Start Page | Object Browser

View Code
Bring to Front
41 Send to Back

@ Lock Controls

Select Forml'
#%  Cut
=3 Copy

X | Delete
< 5 Properties

= mainMenul

Step 3: In the Properties window, type Check the SDK version, and press ENTER to set the Text

property

Buttonl Syvstem. Windows Forms Button

B=]a [@]#
T

BackColor [] Control
Font Tahoma, 10pt
ForeColor - ControlText
Check the SDK Yersion +
B Behavior
ContextMenu (none)
Text
The text contained in the control.

v

v
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4.4.4. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start adding

some code to provide the program's functionality.

Step 1: Double-click the button on the form

Forml.cs [Design]® Start Page

¥ X
N
g o —-— 8
0 Check the SDK Version {
s LT L)
v
< >

= mainMenul

Step 2: Inserting the following code

byte [Jdata = new byte[30];
PACNET.Sys.GetSDKVersion(data);
MessageBox.Show(PACNET.MISC.WideString(data));

mnamespace slKInformation

{
- public partial class Forml - Form
1l
& public Forml( )
|
InitializeComponenty;
- }
& private woid buttonl_Click{ohject zender, Eventirzz &)
|
byte []data = new hwte[30];
PACNET _Bve Geti3lEVersion(datal;
MeszazeBox Show( PACHNET MIEC WideString(datal);
- }
- h
-1
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4.4.5. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a public FTP

server.

Step 1: On the Build menu, click Build SDKInformation

File Edit Yiew Project Debug Tools Test Window Help
" Build Solution  Ctl+Shift+B

| Rebuild Solution

Deploy Solution

Clean Solution

Build SDKInformation

Rebuild SDKInformation

Deploy SDKInformation

Clean SDKInformation

Project Only »

Batch Build...

: Configuration Manager...

|2 Compile Ctr4F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKinformation.exe application and the corresponding PACSDK.dIl and PACNET.dII
files to WinPAC

Tips & Warnings

For applications programming in C# and VB.net with .net compact framework, when
A executing these application on WinPAC, the corresponding PACSDK.dIl and PACNET.dIl must

be in the same directory as the .exe file.

File Edit View Go Favorites |||]][

[I]ﬁgdress | vTernp

) & O

PACcHNET.dI
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4.4.6. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

™

EhKinformat:
L ONeRe
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4.5. First WinPAC Program in Visual C++

The best way to learn programming with WinPAC is to actually create a WinPAC program.
The example below demonstrates how to create a demo program running on WinPAC with Visual C++
To create a demo program with Visual C++ that includes the following main steps:

1. Create a new project

2. Configure the platform

3. Specify the path of the PAC reference
4. Add the control to the form

5. Add the event handling for the control
6. Upload the application to WinPAC

7. Execute the application on WinPAC

All main steps will be described in the following subsection.

Tips & Warnings

A Before beginning a new project, the “Embedded Compact 7 ATL Update” must be installed.
If this update is not installed, the error message “atlconv.h error C2039: IstrlenW" will be

displayed after the program is compiled.
The update can be found by downloading the latest version from Microsoft.

http://download.microsoft.com/download/9/D/D/9DDBD3EC-A43C-4BCE-A7A9-AEE9B1007
BCE/VisualStudioDeviceWindowsEmbeddedCompact7.msi

WP-2000-CE7 Series (WinCE7 Based) User Manual v1.04 Page: 93


http://download.microsoft.com/download/9/D/D/9DDBD3EC-A43C-4BCE-A7A9-AEE9B1007BCE/VisualStudioDeviceWindowsEmbeddedCompact7.msi
http://download.microsoft.com/download/9/D/D/9DDBD3EC-A43C-4BCE-A7A9-AEE9B1007BCE/VisualStudioDeviceWindowsEmbeddedCompact7.msi

4.5.1. Create a New Project

The Visual C++ project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

@) Start Page - Microsoft Visual Studio (Administrator)

Edit View Tools Test Window Help

MNew
Open
’ Close

Close Solution

Save Selected Items
Save Selected [tems As..
Ctrl+Shift+%

i@l | Save All

Export Template...

Page Setup...
Print..

Recent Files
Recent Projects

Exit

4
4

A
E
J

Project... Ctrl+Shift+N
Web Site.. Shift+Alt+N
File... Ctrl+N

Project From Existing Code...
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Step 3: In the Project types pane, expand Visual C++, and then click Smart Device

Step 4: In the Templates pane, click MFC Smart Device Application

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish

New Project

Project types: Templates: NET Framework 3.5 +

» Other Languages
» Other Project Types
» Test Projects

a Visual C++ Visual Studio installed templates
ATL ﬂATL Smart Device Project <#MFC Smart Device ActiveX Control
CLR #@MFC Smart Device Application sf& MFC Smart Device DLL
quFr;:eral =E|Win32 Smart Device Project
\7Smar‘t Device| My Templates
Test 2l Search Online Templates...
Win32

An application for Windows Mobile and other Windows CE-based devices that uses the Microsoft Foundation Class Library

MName: SDKInformation

Solution Name: SDKInformation Create directory for solution

Location: CA\Users\Administrator\Documents\Visual Studio 2008\Projects -

OK

||

Cancel

|
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Step 6: On the first page of the wizard, click Next

MFC Smart Device Application Wizard - SDKInformation ;@gl

M Welcome to the MFC Smart Device Application Wizard

F
Overview These are the current project settings:
Platforms ® Windows Mobile 5.0 Pocket PC SDK Flatform

® Single document interface
Application Type

Document Template Strings Click Finish from any window to accept the current settings.

User Interface Features After you create the project, see the project's readme.tt file for information about the project features

and files that are generated.
Advanced Features

Generated Classes

ne> || Fnish || cancel

Step 7: On the next page of the wizard, select AM335x_WINCE7_SDK to be added to the project, and
then click Next

———=mm
— )

MFC Smart Device Application Wizard - SDKInformation ;uﬂl

=== Platforms

Overview Select platform SDKs to be added to the current project.
Platforms
Application Type

Document Template Strings

Installed SDKs: Selected SDKs:
User Interface Features Windows Mobile 5.0 Pocket PC SDk AM335x WINCE7_SDK
Pocket PC 2003 2
Advanced Features Smartphone 2003
Generated Classes Windows Mobile 5.0 Smartphone 5

3

AM335x_WINCEZ_SDK
(Instruction sets: ARMwv4I

<Pre'vious][ Next = ][ Finish H Cancel
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Step 8: On the next page of the wizard, select Dialog based, and then click next

MFC Smart Device ﬁﬁﬁlicatiun w"erd - SDKInformation

Application Type

Overview Application type: Use of MFC:
Platforms (O single document () Use MFC in a shared DLL
Application Type (® Dialog based @) Use MFC in a static library

Document Template Strings () single document with DocList
User Interface Features
] Document/View architecture support
Advanced Features
Resource language:

=Y (=6)

Generated Classes

<Prevmus]| Mext > ]I Finish H Cancel

Step 9: On the next page of the wizard, click next

-

MFC Smart Device Agﬂlication Wizard - SDKInformatio

User Interface Features

Overview Command bar:

Platforms © Menus only

Application Type Menus and buttons

Document Template Strings

User Interface Features Status bar
Advanced Features Dialog title:
Generated Classes SDKInformation

lﬁg}

<Previ.ou.s|[ Next > H Finish H Cancel
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Step 10: On the next page of the wizard, click next

MFC Smart Device ﬁﬁglication Wizard - SDKInformatiol

Advanced Features

Advanced features:

Overview

Flatforms windows He Ip

Application Type O Printing and print pre

Document Template Strings [ ActiveX controls

User Interface Features B windows sockets

Advanced Features
Mumber of files on recent file list:

Generated Classes

<Prevkms” MNext > H Finish H Cancel

Step 11: On the next page of the wizard, click Finish

MFC Smart Device ﬁaﬁ ication Wizard - SDKInformatiol

Generated Classes

Generated classes:

Overview
CSDKInformationApp
CSDKInformationDlg

Platforms
Application Type
Document Template Strings

User Interface Features

Class name:
Advanced Features CSDKInformationApp
Generated Classes

Base class:

CWinApp

h file:

|5DKInf-:-rma tion.h

cpp file:

|SDKInf-:-rma tion.cpp

< Previous “ Next >

|[ Finish [ cancel
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4.5.2. Configure the Platform

When developing applications by using Visual C++, you must configure the Platform to indicate what
platform and device you intend to download the application to. Before you deploy your project, check

the platform.

On the Debug configuration toolbar, select Release, and then on the Pocket PC 2003 (ARMV4)
configuration toolbar, select AM335x_WINCE7_SDK(ARMv4lI), as shown in the following illustration.

P Debug ~ AM335x WINCE7 S~
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4.5.3. Specify the Path of PACSDK library and header files

The PAC SDK provides the PACSDK library and header files with WP-2000-CE7.
It’s compatible with C++. In order to use a component in your application, you must first add a reference

toit.

Step 1: Right-click the project name, and then click Properties

éﬁlntion F.xpiorer - SDI&Information

2[3@ A

[ Solution SDKInformation’ {1 project)

EBEZI SDK Information
- [ res %Y Build
[£] ReadMe. txt :
Rebuild
h] Resource h :
h] Resourceppe h Deploy

¢+ SDKInformatioy Clean
] SDKInformatioy .
i SDKInformatioy Project Only »

¢+ SDKInformatios Custom Build Rules...
h] SDKInformatios

3 SDKInformatios Tool Build Order...

43 SDKInformatiny Add ¥
C+4] stdafx.cpp

h] stdafxh References...

&5, View Class Diagram

Set as StartUp Project

Debug 4
# Cout

¥

Remove

Rename

Unload Project

Qpen Folder in Windows Explorer

l’,i | B

Properties
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Step 2: In left pane, expand Configuration Properties, and then click Link

Step 3: In the right pane, choose the PACSDK_CE.lib in the Additional Dependencies item

SDEInformation Property Pages

Confignration: | Active(Debug) | Platform: | Astive(XPacSDK_CE (6)) | [ Contigurstion Manager... |
Coma_non P_roperl:i.es ) Additional Deper PACSDK lib E]
=~ Configuration Froperties Tenore A1 Default Librasies ¥o

General Iznore Specific Lib
Debugsi gnore Specific Library
Dieployment todule Definttion File
CiC++ Ldd Module o Asmembly
= Linker .
Ceneral Embed Managed Remune File
Tnput Farce Symbol References
Manifest File Delay Loaded DLL=
Debugzing bsmmbly Link Resome
Sarsten
Optimization
Embedded DL
Advanced
Command Line
Resources
HML Document Crenerator
Brrowss Information
Build Events
Custom Build Step
Authenticode Signing
Additional Dependencies
Specifies additional items to add 1o the bink line {ex; kemels2 Lb); configuration specific.
I
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Step 4: In the right pane, choose the following path in the “Additional Include Directories” item

C:\Program Files\Windows CE Tools\SDKs\N2000_WINCE7_SDK\Include\X86
C:\Program Files\Microsoft Visual Studio 9.0\VC\ce7\atImfc\include

testErx Froperty Pages E' §|

Configuration: |ﬁcﬁve Debug)

Common Properties
= Confignration Properties
General
Debugzing
Dieployiment
= AT+
(eneral
Optirmization
Preprocessnt
Code Generation

Langvage
Precompiled Headers
Outpt Files
Browse Information
Advanced
Command Line
= Linker
Creneral
Input
Mamifest File
Debngging
Swrstern
Optimization
Ermbedded IDL
Advanced
Corumand Line
Eesources
EML Document Generator
Browse Information
Build Events
Custom Build Step
Authenticode Signing

| Platform: | Active(N2000_WINCE?_SDK (36) |

Ad nclude s =C:\Program Files\Windows CE Tonk\SDK:\HQUU[@
Resolve #using References

Diebug Information Format Program Database {fZi)
Suppress Startup Banner Yes (fnologa)

Warning Level Level 2 (/W3)

Dietect 64-bit Partability [smes No

Treat Warnings s Erors No

Additional Include Directories

Specifies one or more directories to add to the include path; vse smi-colon delimited List if more than one.
{/1[path]}

EA
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4.5.4. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; they

are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such as
background color and default text. The values that you specify in the Properties window are the initial

values that will be assigned to that property when the control is created at run time.

Step 1: In Resource View, expand the resources tree by opening the top level folder

Step 2: Open the Dialog folder and then double-click the dialog resource name
IDD_SDKINFORMATION_DIALOG

Resource View - SDKInformation =

=54 SDKInformation
= SDKInformation.rc
+-_J Icon
#-{ 1 Version
[+ SDKInformationppe.rc

quRes:-urce View @ Solution Explorer | Properties

The resource editor appears in the right pane.
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Step 3: From the Toolbox, drag a Button control onto the form

Toolbox 3]
= Dialog Editor Al
R Pointer SDKInformation.xc... - Dialog* ¥ X
IE Button
[X] Check Box
ab| Edit Control
Combo Box
List Box
m Group Box
(¢ Radio Button
An Static Text
Picture Control
[ Horizontal Scroll Bar
B vertical Scroll Bar
D~ Slider Control v |

:£§ewer Ejpﬁr}gn To_dlﬁlff

= ,fJ...|....|....|....|....,|].

- L

BB SDKInformation

Ll

E

TODO: Flace dialog contiols heye.

PRI ¥

Step 4: Right-click the Button control, and then click Properties

E TODO: Flace dislog contial

|
[ |
&  Cut
5a  Copy
£
X

Delete

Add Event Handler...
Insert Activel Control...
v Add Class...
v Add Yariable...

Size to Content

@7 Check Mnemonics
P;operﬁés

RS
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Step 5: In the Properties window, type Check the SDK version, and press ENTER to set the Text
property

Properties _________________®

IDC_BUTTON1 (Button Control) ICeButtonEditor ~

II L3

Appearance A-.
Check be SD version.
Client Ed ge False
Horizontal Alignment Default =
Modal Frame Fale
Multiline Fale
Notify False
e N ] v

Capuon ' '

Specifies the text displayed by the control.

E’E]Reé:juxté Tiew j??}ijdlijﬁ':’ﬁ Explorer }ﬁpmperﬁes "
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4.5.5. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start adding

some code to provide the program's functionality.

Step 1: Double-click the button on the form

SDKInformation.rc.. 327 (£H)] - Dialog* = x

3 5] u a
o m| Check the SDK version ]-
3 5] [] o

R TODO: Flace dialog contiols heye.

Step 2: Inserting the following code

char sdk_version[32];

TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);
MessageBox(buf,0,MB_OK);

Evold CEIEInformationlle: :OnBnClickedButtonly )

{
A TODO: &dd wour control notification handler code here

char sdk_verzion[32];

TCHAR buf[32];
pac_GetilEVersion(=sdk_werszion);
pac_fnz1ToWideltringi=sdk_wversion, buf);
MezsageBox(buf ,0,ME_0K);
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Step 3: Inserting the following code into the header area

#include “PACSDK.h”

#include "stdafx . h"

#include "SDEInformation. h"
#include "SDEKInformationDlg . h"
#Finclude "PACSDE.H"
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4.5.6. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a public FTP

server.

Step 1: On the Build menu, click Build SDKInformation

File Edit View Project Debug Tools Test Wimndow Help
[ﬁ Build Solution Ctc+Shift+B ]
| Rebuild Solution
Deploy Solution

‘ Clean Solution

|| [#% Build SDKInformation
Rebuild SDKInformation
Deploy SDKInformation
Clean SDKInformation
Project Only 3
Batch Build....

; Configuration Manager...

; £ Compile Ctl4+F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKInformation.exe application to WinPAC

|Eile Edit View go|
@ pj =R

-

SR, CERIEE:
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4.5.7. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

™

EhKinformat:
L ONeRe
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5. APIs and Demo Programs

This chapter provides a brief overview of PAC APls and demo programs that have been designed for ICP

DAS PACs.

ICP DAS provides a set of demo programs in different programming languages. You can examine the
sample codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This will

allow developing your own applications quickly by modifying these demo programs.

For full usage information regarding the description, prototype and the arguments of the functions,

please refer to the “PAC Standard APl Manual”

E PAC_Standard API Manuwal 1.1.1 pdf - Adobe Acrobat Pro

BED REE BRE W@ SEO ]
Rer- BEHORE|¢g0ozBED a1 - | [
ol Ml =1 m #s  aw
L |e= 1) 2. PAC API Functions -
- =
i ezl B B ®
- 2.1. System Information APT
4 2 P teeaeans A =[P 2.1 System Information AFT A
pac_GetRotaryID
léfd' [P 213 pac_cetSerialMumber I:F 2.1.1. [:IEIE_GENDdUlENamE
[P 2.1.4. pac_GetsOKversion
[Pais pac_ChangeSiat E paE_GEtRDtarYID
EF 2.1.6. pac_CheckSDKVersion .
217, pac_odleEsiste I:F 2.1.3. pac_GetSeriallumber
gig PSE—EEES“E;’;‘“” [P 214 par_GetSDKVersion
L9, pac_Gelviad Iress
[P 2.1.10. pac_Reboot E 2.1.5, pac_changeSiot
[P 2111, Pac_GatcPuy
o1 pZE_E:ah‘ELEZrSIDn I:F 2.1.6. pac_CheckSDKYersion
[P 2.1.13. Pac_EnableLEDs .
EF 2.1.14. pac_BackwardCompatible E 2'1'?' FIEIE_MDC'U'EE}{lStB
EF 2.1.15. pac_GetEhootversion E 218 Flal: GEtOSI"."IErSiDn
[P 2116, pac_cetComMapping -
[P 2.1.17. pac_GetvoduleTyps E 2.1.9, pac_Geﬂ\ﬂaE.-’-‘-.ddress
[Pa11s pac_GetPachetyersion E
EF 2.1.19. pac_PuzzerBeep = 2'1' 1D' paE—REE'DDt
= [P 2.1.11. Pac_GetCPUversion —

[P 2.1.12. Pac_EnablelED

[P 2.1.13. Pac_EnableLEDs

[P 2114 pac_BackwardCompatible
EF 2.1.15. pac_GetEbootversion

l:lg 2.1.16. pac_GetZomiapping

[P 2117 pac_GettModuleType

I:P 2.1.18, pac_GetPacMetersion

[P 2.1.19. pac_Puzzergeep

[
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5.1. PAC Standard APIs

The diagram below shows the set of each system operation API provided in the PACSDK.

| [ » Watchdog
I > UART

» Registry

> Buzzer
> LED

System Operation
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5.1.1. VB.NET Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APIs
in a VB.NET language environment. The following demo programs can be found by downloading the
latest version from ICP DAS web site.

For VB.NET applications, these demo programs can be obtained from:

https://www.icpdas.com/en/download/show.php?num=2409

File name: Standard_PAC_demo_Am335x_WinCE7.zip

Folder | Demo ‘ Explanation
buzzer buzzer Shows how to make a simple buzzer beep.
Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation
version, SDK version, etc.
Retrieves information about the
GetRotarylD GetRotaryIlD
status of the rotary switch
Shows how to read/write data
Memory Memory values from/to the EEPROM or
the backplane of the SRAM
MicroSD MicroSD_Management | Shows how to manage the microSD

Writes the managed cod for the rich graphical

VB_Ul_Call_VC_Realti | user interface that does not require true

me real-time
RealTimeTest
performance
Shows how to use the function of JIT compiler
VBOnly
and garbage collector
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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5.1.2. CH# Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APIs

in a C# language environment. The following demo programs can be found by downloading the latest

version from ICP DAS web site.

For C# applications, these demo programs can be obtained from:

https://www.icpdas.com/en/download/show.php?num=2409

File name: Standard_PAC_demo_Am335x_WinCE7.zip

Folder

buzzer

Demo

buzzer

Explanation

Shows how to make a simple buzzer beep.

Devicelnformation

Devicelnformation

Retrieves information about the OS version, CPU

version, SDK version, etc.

GetRotarylD

GetRotaryIlD

Retrieves information about the

status of the rotary switch

Shows how to read/write data

Memory Memory values from/to the EEPROM or
the backplane of the SRAM
MicroSD MicroSD_Management | Shows how to manage the microSD

CSharp_Ul _call_ VC_Re

Writes the managed cod for the rich graphical

user interface that does not require true real-time

altime
RealTimeTest performance
Shows how to use the function of JIT compiler
CSharpOnly
and garbage collector
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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5.1.3. Visual C++ Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APIs

in a Visual C++ language environment. The following demo programs can be found by downloading the

latest version from ICP DAS web site.

For Visual C++ applications, these demo programs can be obtained from:

https://www.icpdas.com/en/download/show.php?num=2409

File name: Standard_PAC_demo_Am335x_WinCE7.zip

Folder |

buzzer

Demo

buzzer

Explanation

Shows how to make a simple buzzer beep.

Devicelnformation

Devicelnformation

Retrieves information about the OS version,

CPU version, SDK version, etc.

GetRotarylD

GetRotaryID

Retrieves information about the

status of the rotary switch

Shows how to read/write data

Memory Memory values from/to the EEPROM or
the backplane of the SRAM
MultiRT MultiRT Shows how to manage the microSD

RealTimeTest

RealTimeTest

Writes the managed cod for the rich
graphical user interface that does not require

true real-time

performance
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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5.2. PACIO APIs
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5.2.1. VB.NET Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC 10 APIs in a

VB.NET language environment. The following demo programs can be found by downloading the latest

version from ICP DAS web site.

For VB.NET applications, these demo programs can be obtained from:

https://www.icpdas.com/en/download/show.php?num=2409

File name: Standard_PAC_demo_Am335x_WinCE7.zip

XVBoard/XV107

Explanation

XV107_Modbus_RTU_Master_ | Shows how to use the XV107 module of
VB_demo the XV-board

Remote
(I-7000 or I-87K modules
in RU-87Pn I/0O unit)

For full details regarding the remote I/0O modules and its demos, please
refer to:

File name: Applicabled_Demo_for_7K_Module
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5.2.2. C# Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC 10 APIs in a C#
language environment. The following demo programs can be found downloading the latest version from
ICP DAS web site.

For C# applications, these demo programs can be obtained from:

https://www.icpdas.com/en/download/show.php?num=2409

File name: Standard_PAC_demo_Am335x_WinCE7.zip

Folder Demo Explanation
Shows how to use the XV107 module of
ModbusRTU_Master_Console
the XV-board in console mode
XVBoard/XV107
XV107_Modbus_RTU_Master | Shows how to use the XV107 module of
_demo the XV-board
S For full details regarding the remote I/0O modules and its demos, please
(I-7000 or I-87K modules in refer to:
RU-87Pn 1/0 unit) File name: Applicabled_Demo_for_7K_Module
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5.2.3. Visual C++ Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APIs
in a Visual C++ language environment. The following demo programs can be found downloading the
latest version from ICP DAS web site.

For Visual C++ applications, these demo programs can be obtained from:

https://www.icpdas.com/en/download/show.php?num=2409

File name: Standard_PAC_demo_Am335x_WinCE7.zip

Explanation

For full details regarding the remote I/0O modules and its demos, please

Remote
(1-7000 or I-87K modules refer to:
in RU-87Pn I/0O unit) File name: Applicabled_Demo_for_7K_Module

B AEEF A

e-USB400 RD2 Miller

e-PoE400 RD2 Jeff

e-PoE200 RD2 Jeff

e-LCell4 RD2 Samuel

e-ADS16 RD2 George

e-D96S RD2 George
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6. 1/0O Modules and SDK Selection

This chapter describes how to select a suitable 1/0 expansion module and the corresponding SDK library

to be used for developing programs on WinPAC series devices.

Selecting an SDK Library for /O Expansion

\ : I-8KE4 ET-7000
RS-232/RS-485

RU-87Pn M-7000 17000

0 Local 1/0 Module (XV-Board)

There are more than 8 XV-Board available for expanding the function of the WP-2000-CE7. The

following table shows the appropriate SDK library to be used for I/O modules.

Module Native SDK .NET CF SDK

XV-Board Modbus Demo Modbus Demo

For more detailed information about these support modules, please refer to
https://www.icpdas.com/en/product/guide+Remote | O  Module and Unit+PAC %EF%BC%86a

mp; Local | O Modules+XV-board

WP-2000-CE7 Series (WinCE7 Based) User Manual v1.04 Page: 120


https://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+XV-board
https://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+XV-board

9 RS-485 (1-7000 series and M-7000 series)

I-7000, M-7000, RU-87Pn and high profile I-87K series modules connect to WP-2000-CE7 via a
twisted-pair, multi-drop, 2-wire RS-485 network.

» 1-7000 series 1/0 modules

Module ‘ Native SDK ‘ .NET CF SDK ‘
I-7000 series PACSDK.dII PACNET.dII
I-7000 series with I-7088 (D) PACSDK_PWmM.dII PACNET.dII

For full details regarding 1-7000 series I/0 modules and its demos, please refer to:

https://www.icpdas.com/en/download/show.php?num=2409

File name: Standard_PAC_demo_Am335x_WinCE7.zip

» M-7000 series I/0 modules

Module Native SDK .NET CF SDK

M-7000 series Modbus Demo Modbus Demo

For more detailed information about M-7000 series modules using Modbus protocol and its demos,
please refer to:

https://www.icpdas.com/en/download/show.php?num=2409

File name: nModbus.zip

» RU-87Pn + I-87K series I/O modules

Native SDK .NET CF SDK

RU-87Pn + |-87K PACSDK.dII PACNET.dII

»  Other specified 1I/0

Module Native SDK .NET CF SDK

[-7088W PACSDK_PWM.dII PACNET.dII
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9 Ethernet (ET-7000 series and I-8KE4/8-MTCP)

The Ethernet I/O devices available include ET-7000 and I-8KE4/8-MTCP, and support the

Modbus/TCP communication protocol.

Module ‘ Native SDK ‘ .NET CF SDK ‘
ET-7000 Modbus Demo Modbus Demo
I-8KE4/8-MTCP Modbus Demo Modbus Demo

For more detailed information about ET-7000 and |-8KE4/8-MTCP series modules using Modbus protocol
and its demos, please refer to:
https://www.icpdas.com/en/download/show.php?num=2409

File name: nModbus.zip
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7. WP-2000-CE7 Updates

This chapter provides information of the WinPAC OS and SDKs, and a guided tour that demonstrates the
steps needed to update the WinPAC OS and SDKs.

ICP DAS will continue to add additional features to WinPAC SDK and OS in the future, so we advise you to
periodically check the ICP DAS web site for the latest updates.

Both the files of OS updates and SDK updates can be found by downloading the latest version from ICP
DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-2241/

0OS_Image
update_from_Micro_SD

update_from_file

PlatformSDK
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7.1. OS Updates

OS updates are part of the WP-2000-CE7 updates services to provide additional and more efficient
features and functionality for WP-2000-CE7 operating system.

The updates files of OS image can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-2241/o0s_image/

e update_from_Eshell or Micro_SD
update_from_file

There are two ways to update the OS:

OS image
' I
1 1

update_from_Eshell_
or_Micro_SD

update_from _file

1. Update from eshell (Please refer to section 7.1.1)

(We recommend that you use this one for more quicker and easier to update)

2. Update from micro_SD (Please refer to section 7.1.2)
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7.1.1. OS Updates using Eshell

By default, the OS updates via LAN. Therefore, to update the

OS image, make sure LAN is connected to the PC.

Step 1: Get the latest version of the installation package file and then unzip it

The latest version of the installation package file can be found from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/os image/update from eshell o
r_micro_sd\

Step 2: Run the registry clear.exe

The registry.exe can be found by downloading the latest version from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-2241/pc tools/eshell

Run the
registry clear.exe

Step 3: Place the rotary switch in position 3, OS update mode
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Step 4: Run the ESHELL.exe, and then restart the WP-2000-CE7

ESHELL

The ESHELL.exe can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/pc tools/eshell

Step 5: Select the device which you want to update the OS image, and then click OK

Select the device name which you want to update the OS image from the list.

Entet Device M ame: 0K

[WINPAC270_535

Cancel
Or Sedect From the List

Reset devices to
automatically puk
names on the
list.

Step 6: Select the latest version of the OS image file

Look in: | ) WE523x_20140821_Ver1.0.04_ml =~ @B e E-

a CIE bing
My Recent
Docurnents
ot Wi O Dubag Bhell - WF_ER000 SARATd P Wal b Disigd esle e 00 _os NF0T_ima go'n g 2 P '
- YA I=b (o Tew e
o A | w| #|@
Desk,lm aF_unhil | Baetinader Bersios 1,8, §F; 18,7 ,08,50, e eEeE i e ake
Sownlesding “ViRd ol PitlaFE0 sapdes’ v - TEHE_ ot INEE_ i megeiowp - Plulapdate_fron [ vbe i1 en 0
Huspleg 1a image e OF_RRAPE L.
-__,.’ Eennriling to oF_nbvil esing Dihereei,.,
My Documents
L E]
My Computes

My Ne&itwuk File: marne: WE BIN
Filez of tlype: NE Image
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Step 7: Once the procedure is completed, the “Warning !” dialog box will appear as below shown,

then turn the rotary switch in position 0, normal mode

Warning

"'-..‘ Reboot this device right nowy |
L Flease turn the rotary switch to 0 - normal

Step 8: Click the OK button

Warning

'."-..‘ Reboot this device right now |
L Please turn the rotary switch to 0 - normal

Step 9: Check the OS version

Start the PAC Utility, and then select the “Device Information” tab to check the current OS

version.

Double-click the
PAC Utility shortcut

st [ ] cPU Type: [wPsz3c |
Stz [ ] Serial Number: [p1-a8-2c-1F-1600-0020 |
Slot 3: I:I Backplane ‘Yersion: |NJA |
Slot 4 |:| CPU Yersian: |N;A |
Slot 5 I:I 0S Yersion: |1001 |
Slot &: |:| NET CF arsion: |3,5,?333,gg |
Slat 7: |:| SQL CE Yersion: | |

|

PACSDK Version: |4,3,n.u
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7.1.2. OS Updates using micro_SD

The microSD card can be used to reinstall the WP-2000-CE7 OS image to factory default settings in the
event of the WP-2000-CE7 failure.

Step 1: Get the latest version of the installation package file, then unzip the file, and then copy them
to microSD card

The latest version of the installation package file can be found from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/os image/update from eshell o

r_micro_sd\

& WP523x 20140821 Ver.1.0.0.4 ml

File Edit Wiew Favorites Tools Help

eﬁack b \_) L@ ;\’ Search W= Falders = ¥

address | Cropdate_from_Behell_or_Mirro_SDVWES23x_2014082K_

EBOOTSD nb0
(23] | nE0 i

BEEB

TE {acin

B4 KE 0 ]

XLDRBI{&ND.nNJ XLDRS[} nbl

NEO fi% NED &3

A

icro
m<eS

Adapter

Step 2: Plug the microSD card into microSD slot

Step 3: Turn the rotary switch in position 5, OS update mode
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Step 4: Reboot the WP-2000-CE7

Step 5: Wait a few minutes for the following desktop to be displayed

Step 6: Turn the rotary switch in position 0, normal mode

Step 7: Reboot the WP-2000-CE7

Step 8: Check the OS version

Start the PAC Utility, and then select the “Device Information” tab to check the current OS

version.

Double-click the
PAC Utility shortcut

Slot 1: I:I CPU Type: |wp523x |
Stz [ ] Serial Mumber: |p1-s8-2C-1F-16-00-00-20 |
Slat 3: I:I Backplane Yersion: |Nfﬁ |
Slat 4: |:| CPU Yersion: |NIA |
Slot 5 I:I 05 Yersion: |1nu1 |
Sote: [ | MNETCFVersion:  [3.57338.00 |
Slat 7 |:| SQL CE Yersian: | |

|

PACSDK Yersion: |4,3,u.n

WP-2000-CE7 Series (WinCE7 Based) User Manual v1.04 Page: 129



7.2. SDK Updates

SDK updates are part of the WP-2000-CE7 update services to provide additional and more efficient
features and functionality for WP-2000-CE7 operating system.

The updates files of SDK files can be found by downloading the latest version from ICP DAS web site.
https://www.icpdas.com/en/download/show.php?num=2409

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-2241/sdk/

— .
.
— .
.
—
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7.2.1. SDK Updates for VB.NET or C#

You can just change the old one with a new one.

Step 1: Get the latest version of the PACNET.dII

The latest version of the PACNET. dll can be obtained from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/sdk/pacnet/

Step 2: Copy the PACNET.dII file to PC and WP-2000-CE7

The DLL files on PC are located at anywhere only the solution can reference it.

The DLL files on WP-2000-CE7 are located at the same directory as the .exe file.
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7.2.2. SDK Updates for C++

You can just change the old one with a new one.

Step 1: Get the latest version of the VC++ components

The latest version of the VC++ components can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/sdk/pacsdk/

Step 2: Copy the latest version of header files and libraries to Host PC

The header files are located at:

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Include\Armv4i
The libraries are located at:

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Lib\ARMv4|

Step 3: Copy the latest version of DLL files to WinPAC

The DLL files are located at:
\System_Disk\ICPDAS\System
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Appendix. A. Tips — How to
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A.1. How to Online Debug the WP-2000-CE7 Program

Here are step by step instructions on how to online debug the WP-2000-CE7 program.

Tips & Warnings

A

Before starting online debug the WP-2000-CE7 program, make sure that the WP-2000-CE7

SDK has been installed correctly.

For more information on how to install the WP-2000-CE7 SDK, please refer to 4.2. Installing
WP-2000-CE7 SDK.

Step 1: Copy the following files to the \System_Disk\icpdas\system on the WP-2000-CE7

By default, these files are located on the development computer at C:\Program
Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>.

clientshutdown.exe

CMAccept.exe

ConmancClient2.exe

eDbgTL.dll

TcpConnectionA.dll

Step 2: Run the ConmancClient2.exe and then CMAccept.exe on the WP-2000-CE7

I]].&erESS | WSystem_Diskicpdasisysten {
w & B s 8 8 (8] 8] (8
atlan atlan autainit mfcaochs mfc80cht mfc80dewy mfcS0eny mfcS0esp ﬁ:BElfreE
a @ (8] (8] (8] |8 |8 & (&)
rnfc80ipn rnfcB0kar rnfcB0u rnfc20ud mfc90chs mfc90cht mfc90dey mfc@0enu meQDES%
a @ (8] (8] (@) & 8] (3] (&5
rnfcS0fra rnfc20ita rnfc2dipmn rnfc20kor rnfcS0u rnfc20ud s L=y w90 },
W % (8 & [8] [ ) ¢
pacnet pacsdk  pacsdk_pwmn  eDbgTL  Teplonne... dientshiN,.  (CMiccept! Cunmancw
ZL3e-409,
‘w%quwﬂwwvwm—w ne———
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Step 3: On the Tools menu, click the Options...

File Edit View Project Build Debug Test Window Help

@ A RAA™ N~ | & 3 Lﬁ| ) v‘ E Attach to Process... Ctrl+Alt+P

© AM335x_WINCE7_SDKAF v | @ @ 42 | & | Device Security Manager..

Q; Connect to Device...

~Device Emu o anager o~ N Mo
NATP jorthe__ TR et~ N

External Tools...

Import and Export Settings...

@

Step 4: In the left pane, expand Device Tools node and select Devices

Step 5: In the Show devices for platform:, select AM335x_WINCE7_SDK and then click Properties

Options

Environment
Projects and Solutions

! evices for platform: =
| AM335x_WINCE7_SDK

Source Control
Text Editor 2 " \
Database Tools ~ -
. AM3I35x_WINCE7_SDK ARMVY Device
Debugging N E
Device Tools
Genera | Rename. |

Devices ——
Form Factors

HTML Designer

Office Tools

Test Tools

Text Templating

Windows Forms Designer

Workflow Designer

Default device:

AM335x_WINCE7_SDK ARMV7 Device
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Step 6: Click the Configure...

-

- |
AM335x_WINCE7_SDK ARMV7 Device Properties | LE’] 28 .

Default output location on device:

Transport: |

|TCP Connect Transport /ﬂ ‘ Configure... l

Bootstrapper:

|ActiveS}rnc Startup Provider 6 | Configure..

Detect when device is disconnected

QK ‘ ‘ Cancel

Step 7: Select the Use specific IP address:, and then type the IP address of WP-2000-CE7

Configure TCP/IP Transport m

"] Use fixed port number: 5655

Device IP address

(7) Obtain 22 1D 2ddress automatically using ActiveSync

*" (@ Use specific IP address:

10.1.0.96]

OK J ‘ Cancel
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Step 8: Click the OK, and then click OK to end the dialog

AM335x_WINCE7_SDK ARMV7 Device Properties

Default output location on device:

L5 |

Transport:

[TCP Connect Transport A l l Configure...
Bootstrapper:

[ActiveSync Startup Provider '] ‘ Configure..

Detect when device is disconnected

Options

> Environment

> Projects and Solutions
> Source Control

> Text Editor

» Database Tools

> Debugging

a4 Device Tools

General
| Devices|
Form Factors
> HTML Designer
> Office Tools
> Test Tools
» Text Templating
> Windows Forms Designer
> Workflow Designer

Show devices for platform:

IAM335)(_WINCE?_S DK

Devices:

AM335x_WINCE7_SDK ARMV7 Device

Save As..

Rename...

il

Delete

Default device:

AM335x_WINCE7_SDK ARMV7 Device

-
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Step 9: On the Tools menu, click the Connect to Device...

File Edit View Project Build Debug |Tools | Test Window Help
|_—i| Attach to Process... Ctrl+Alt+P

/mﬁemanage. =
8, Connect to Device..

& | Device Emulator Manaaer,
¥4, | Connectto Database...
! Connect to Server...

E-;j Code Snippets Manager.. Ctrl+K, Ctrl+B

Step 10: Wait for the connection to be established

.

To "AM335x_WINCE7_SDK ARMV7 Device"

Connection succeeded.

Tips & Warnings

Q If the connection fails, as shown below, please repeat the step 2 to step 9 to try it again.

L -

2 :

To '"AM335x_ WINCE7_SDK ARMVT Device'

Connection failed. ActiveSync bootstrap initialization
failed.
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A.2. How to Automatically Synchronize WinPAC Clock

You can synchronize your WinPAC clock with an Intern

et time server.

If synchronization is enabled, the WinPAC clock is synchronized with an Internet time server.

Step 1: Double-click the PAC Utility on the desktop

Double-click the

PAC Utility shortcut)

Step 2: On the General tab, press Configure button

PAC Utility [1.2.0.6] ! E

File Help

General | Display | 1P Config | Network | Device Information | &

Lo Execution I Rotary Execution |

Backplane Battery
Batteryl .

Welcome to use PAC Uiility
This tool will help you easy 1o
use PAC CE series,

Task Bar setting:
[ Auta Hide
[] always On Top

HIYE Reqgistry:
0”=-' 4 e T ; =

[ ] Enable autorun in plugging USE Disk
[] Enable Autorun in plugging Micra S0

Configure the synchronization with a time server /|

Canfigure
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Step 3: Select the domain name from the Server

drop-down list, and then enter a value in the
Autoupdate Frequency field

Step 4: Check the Automatically synchronize with an

internet time server check box

Step 5: On the File menu, click Save and Reboot

Internet Time 1.0.0.1

Stepl: Server:  |tock.usno.nasy. mil El

Step2: Autoupdate Frequency: | | minute
Stepa:

|:| Autornatically synchronize with an internet tirme server

| Update Mow

Save and Reboot

Reboot

Restore Utility Default Settings
Exit

Step 6: The WinPAC will automatically synchronize with an internet time server regularly

Step 7: Click the Update Now button to synchronize WinPAC clock immediately

Internet Time 1.0.0.1

Stepl: Server: | tock.usno.nawy, mil El
Step2: Autoupdate Frequency: | | minute
Step3:

|:| Autornatically synchronize with an internet time server

| Update Mow
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A.3. How to use User Account Control in WinPAC
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A.3.1. How to Create an User Account

Here are step by step instructions on how to add a user account.

Step 1: Double-click the PAC Utility on the desktop

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and Password, and
then click Add button

PAC Utility [1.2.2.0] !
File Help

[General IGeneraI2 IDispIay I IF Config | Metwork |De\rice Infor mation I AL Execution I Rotary E}{EI 1 I 4

[ Access | Login |

zer Marme Passwiord
ficroes ) | 4ol | Delete
User hame | Password |
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Step 3: The user has been added to the allowed under the remote login and included in the following
list

PAC Utility [1.2.2.0] !
File Help

[General IGeneraI2 IDispIay IIF' Config | Network |Device Infor mation I Autn Execution IRDtary E}{EI i I »

[ Arcess | Login |

User Name Password

ficP as [ [+~ | add | Delete

User name | Password

Step 4: On the File menu, click Save and Reboot for changes to take effect

Save and Reboot
Reboot
Restore Utility Default Settings
Exit
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A.3.2. How to Use Telnet to remote login the WinPAC from PC

Here are step by step instructions on how to use telnet to remote login the WinPAC from PC.

Step 1: On the PC, open a MS-DOS command prompt

U, ST UL ORRUEE Y. | oo G
=W > 7
A5 Windows Catalog g

<

‘& Windows Update

m Programs 4

2. Type “cmd”

;~ Documents
D * Sefk
7 g
(7] upport

start | o CwiDows\syste. .

s» | Windows XP Professional

[ QK ][ Cancel ] [ Browse...

Step 2: At the command prompt, type “telnet (IP address)”

e (CAWINDO WSisystem 32w md _exe

C-“Documents and Settingz“MWindows>telnet 168.1.8.31
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Step 3: The connection has been set up, and then type the name and password

+ Telnet 10.1.0.31

llelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Pazsword:

Step 4: The remote login has been completed

Telnet 10.1.0.31
Wlelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Paszword:
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A.3.3. How to Remove a User Account from the Login List

Here are step by step instructions on how to remote the user from the login list.

Step 1: Click a user from the list which you want to remove, and the user will display in the field, and

then press Delete to delete the user from the login list

PAC Utility [1.2.2.0] !
File Help

[General IGeneraI2 IDispIa\; IIF' Config | Netwark |Device Information IAUID Execution IRDtary Exg 1| P

[ﬂccess| Login |

User Marme Password

icP Des | [ | add || Dekte

User name | Password

Step 2: On the File menu, click Save and Reboot for changes to take effect

Save and Rebaoot
Reboot
Restore Utiity Default Settings
Exit
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A.4. How to change the battery

RTC is retained by a Li-ion battery, which can supply continuous power for 10 years. The battery design
has the added function of preventing data from being lost while replacing the battery. The following

figures show the location of the battery installed in the WinPAC CPU board.

Checking the current battery power

1. Run the PAC utility and check the Battery 1 fields that display the current status. Refer to Section 3.1
PAC utility “General” for more details. If the power level is low that the battery should be replaced.

2. When programming this, call the pac_GetBatteryLevel() API function in the PACSDK.dIl to check
whether the battery power is low. When the power of the battery is low, it’s recommended that the
battery is replaced immediately, otherwise the RTC time will be reset.
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Replacing the battery

Power off the WinPAC device.

Remove the CPU board.

Remove the battery that is running low on power from the battery holder in CPU board.
Insert a new battery.

Set the RTC time.

oA N

Ordering information

Battery type: BR1632 (Part number is 2LB010 for ICP DAS)

For more detailed information, contact your local sales office or distributor.
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A.5. How to Using the Practical Functions of the 3G/4G I/O Module

The Mobile network module of WinPAC series (Except for WP-2241M-CE7) that use the 3G/4G network

to implement SMS and GPRS connection to send and receive functions.
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A.5.1. How to Auto Dial 3G/4G GPRS network and redial when the network
disconnected

The AutoDialer allows user to automatically dial GRPS network after boot.

When the GRPS network disconnect the AutoDialer will automatically re-dial Internet access.

Tips & Warnings

ABefcre installing the SIM card, please cancel the PIN lock function of SIM card;
otherwise you will not be able to dial the Internet

The demos can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/demo/3g modem/autodialer/

The description of the demo can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac _am335x/wp-2241/document/faqg/development/

W5-13_How_to_use_Auto_dial_GPRS_network_and_redial_when_the_network_disconnected_en
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A.5.2. How to Use the SMS Function and Get the GPS Data

The 3G/4G modem allows the user to use the SMS function and get the GPS data.

The APl manual can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/demo/3g modem/3g modem sms demo/gs

m lib manual v1.0.1.pdf

The demos can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/demo/3g modem/3g modem sms demo

The description of the demo can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac _am335x/wp-2241/document/faqg/development/
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-2241/demo/3g_modem/3g_modem_sms_demo/gsm_lib_manual_v1.0.1.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-2241/demo/3g_modem/3g_modem_sms_demo
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-2241/document/faq/development/

A.5.3. How to Synchronize the System Time by GPS Data

The demos can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/demo/3g modem/gpstimesynchronization

The description of the demo can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-2241/document/fag/development/
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Appendix. B. XV-Board Modules

The XV-board series are for LP-2241M, WP-2000-CE7. One PAC can
only plug only one XV-board. The XV-board series have following
common specification:

* Dl channelis dry contact, sink type.

* DO channel is open collector, sink type.

DIO Expansion

DI DO
Sink/Source Sink/Source

XV107 Source Sink

8 Wet 8
XV107A Sink Source
XV110 16 Dry/Wet Sink/Source - -
XV111 Sink

- 16
XV111A Source

Relay Output Expansion

Relay Output

Channel Sink/Source Channel
2 Signal Relay
XV116 5 Wet Sink/Source
4 Power Relay

Multi-Function Expansion

XV308 DI+D0O=8 Source Sink

Dry/Wet DI+DO=8
XV310 4 5 4 Sink Source

For more detailed information about these support modules, please refer to
https://www.icpdas.com/en/product/guide+Remote | O  Module and Unit+PAC %EF%BC%86a
mp; Local | O Modules+XV-board
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Appendix. C. Revision History

This chapter provides revision history information to this document.

The table below shows the revision history.

Revision ’ Date ’ Description

1.0.1 December 2018 | Initial issue
Changed the specifications of FRAM and COM3 in section 1.2.
1.0.2 June 2019
Specification
1.0.3 August 2019 Changed the XV-board installation 2.2.1. Mounting the XV-Board
Added the 3G/4G Communication LTE Module installation in section
1.0.4 November 2021

2.2.3. installing the 3G/4G Communication LTE Module
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